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Capítulo 1: Introducción
Harmony es un software de animación completo que permite crear todo tipo de proyectos de animación creativos.
Incluye distintas herramientas y funciones.

En la Guía de introducción, aprenderá las principales funciones que abarcan los conceptos básicos de Toon Boom
Harmony, y que le permitirán ponerse al día rápidamente. Consulte la documentación completa de Toon Boom
Harmony disponible en línea en docs.toonboom.com para aprender acerca de todas las herramientas y opciones,
así como sobre las técnicas avanzadas.

Esta guía se divide en las siguientes partes:

• Acerca de la pantalla de bienvenida

• Creación de una escena

• Acerca de la interfaz en la página 11

• Cómo dibujar en la página 17

• Cómo pintar en la página 19

• Creación de una animación tradicional en la página 23

• Aplicación de morphing a dibujos en la página 31

• Importación de imágenes de mapa de bits en la página 35

• Creación de un personaje Cut-out en la página 43

• Uso de deformadores en la página 53

• Animación de un personaje Cut-out en la página 71

• Creación de plantillas en la página 77

• Configuración de una escena en la página 81

• Creación de un multiplano en la página 95

• Configuración de objetos en el espacio 3D en la página 101

• Animación de objetos y de la cámara en la página 89

• Importación de sonido y sincronización de labios en la página 105

• Adición de efectos a una escena en la página 109

• Exportación de una película en la página 119
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Capítulo 2: Acerca de la pantalla de bienvenida
Al iniciar Toon Boom Harmony, aparece la pantalla de bienvenida. Si ya hay una escena abierta, puede mostrar la
pantalla de bienvenida seleccionando Help > Show Welcome Screen (Ayuda > Mostrar pantalla de bienvenida).

La pantalla de bienvenida permite:

1. Crear escenas

2. Seleccionar la resolución de la escena

3. Abrir escenas recientes de una lista

4. Agregar o eliminar una resolución de escena personalizada

5. Abra Harmony directamente sin abrir primero la pantalla de bienvenida.

Para mostrar la pantalla de bienvenida más adelante, vaya al menú superior y seleccione Help > Show
Welcome Screen (Ayuda > Mostrar pantalla de bienvenida).

6. Abrir tutoriales en vídeo de Harmony

7. Abrir la página de soporte en línea

8. Abrir escenas desplazándose a las mismas

7



Harmony 14.0 Premium - Guía de introducción (servidor)

8



Harmony 14.0 Premium - Guía de introducción

Capítulo 3: Creación de una escena
Todas las escenas creadas mediante Harmony Stand Alone son independientes y locales del equipo. Puede crear o
abrir una escena utilizando la pantalla de bienvenida.

Creación de una escena desde la pantalla de bienvenida

1. En el campo Name (Nombre), escriba el nombre de la escena.

2. Para seleccionar la ubicación de la escena, en la sección Location (Ubicación), haga clic en Browse (Exa-
minar).

NOTA: En general, el nombre de la escena no debe superar los 23 caracteres y no puede contener caracteres
especiales, como *&^%!.

3. En el menú Camera Size (Tamaño de cámara), seleccione la resolución de la escena y haga clic en Create
Scene (Crear escena).

Se crea una nueva escena.
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Capítulo 4: Acerca de la interfaz
Es importante que esté familiarizado con los siguientes elementos de la interfaz de usuario, ya que le servirán de
ayuda para comenzar a usar Toon Boom Harmony. En esta guía puede aprender más acerca de los puntos que se
describen aquí y de cómo usarlos en un contexto de producción.

Al iniciar Toon Boom Harmony por primera vez, el espacio de trabajo predeterminado está desactivado. Contiene
todos los elementos principales que necesita usar.

Agregar una vista

1. Realice una de las siguientes acciones:

‣ Seleccione la vista que desee agregar en Windows > vista deseada (Ventanas > vista deseada).

‣ En la esquina superior derecha de una vista, haga clic en el botón Add View (Agregar vista) y
seleccione.

‣ una vista de la lista. Puede abrir varias instancias de la misma vista, excepto para las vistas de línea de
tiempo, propiedades de herramienta, color y dibujo.
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Capítulo 4: Acerca de la interfaz

La vista aparece como una pestaña de forma predeterminada.

Anclaje de una ventana

1. Arrastre la ventana por su pestaña y realice una de las siguientes acciones:

‣ Coloque la ventana sobre otras pestañas existentes y agréguela a las demás.

‣ Coloque la ventana por encima, por debajo o junto a una vista existente. Al acercarse al borde de una
vista, aparece un rectángulo negro con fondo azul, que indica dónde se insertará la vista.
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Vista de propiedades de la herramienta

La vista de propiedades de la herramienta contextual contiene las opciones y operaciones más comunes
relacionadas con la herramienta seleccionada actualmente. Al seleccionar una herramienta en la barra de
herramientas Tools (Herramientas), se actualiza la vista de propiedades de la herramienta.

Por ejemplo, si elige la herramienta Select (Seleccionar) en la barra de herramientas Tools (Herramienta), la
vista de propiedades de la herramienta muestra las opciones y operaciones relacionadas con la herramienta Select
(Seleccionar), como Snap to Contour (Ajustar a contorno), Snap and Align (Ajustar y alinear), Flip Horizontal (Voltear
en horizontal) y Flatten (Acoplar).

Interfaz de navegación

Toon Boom Harmony permite acercar, alejar, rotar, panear y restablecer vistas para navegar fácilmente por la
interfaz.

Comando Acción Métodos de acceso
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Capítulo 4: Acerca de la interfaz

Zoom In (Acercar) Acerca la vista.

View > Zoom In (Ver >
Acercar)

Pulse 2 o gire la rueda del
ratón hacia arriba.

En la vista de línea de
tiempo, gire la rueda del ratón
hacia arriba.

Zoom Out (Alejar) Aleja la vista.

View > Zoom Out (Ver >
Alejar)

Pulse 1 o gire la rueda del
ratón hacia abajo.

En la vista de línea de
tiempo, gire la rueda del ratón
hacia abajo.

Zoom In or Out (Acercar o alejar) Acerca o aleja la vista.
Gire la rueda central del ratón
hacia arriba o hacia abajo.

Pan (Panear) Se mueve en paralelo a la vista.

Mantenga pulsada la barra
espaciadora y arrastre en la
dirección en la que desea
panear la vista.

Recenter view (Volver a centrar vista) Vuelve a centrar la vista sobre el puntero. Pulse N

Reset Pan (Restablecer paneo)
Restablece el paneo de vista a su
posición predeterminada.

View > Reset Pan (Ver >
Restablecer paneo)

Pulse Mayús + N

Reset View (Restablecer vista)
Restablece la vista a su posición
predeterminada.

View > Reset View (Ver >
Restablecer vista)

Pulse Mayús + M

Reset Rotation (Restablecer rotación)
Restablece la rotación de vista a su
posición predeterminada.

View > Reset Rotation (Ver
> Restablecer rotación)

Pulse Mayús + X

Reset Zoom (Restablecer zoom)
Restablece el zoom de vista a su
posición predeterminada.

View > Reset Zoom (Ver >
Restablecer zoom)

Toggle Full Screen (Alternar pantalla
completa)

Amplía la vista seleccionada a la pantalla
completa, lo que se consigue en tres
fases.

En primer lugar, la vista seleccionada se
amplía a la anchura o altura máximas,
pero conserva las vistas de herramienta,
como la vista de color y de propiedades
de la herramienta.

En segundo lugar, la vista se amplía a

View > Toggle Full Screen
(Ver > Alternar pantalla
completa)

Pulse Ctrl + F
(Windows/Linux) o ⌘ + F
(Mac OS X)
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pantalla completa.

Por último, la vista regresa a su tamaño
original.

Rotate 30 CW (Rotar 30 derecha) Rota la vista de cámara 30 grados a la
derecha, como una mesa de animación.

View > Rotate View CW
(Ver > Rotar 30 derecha)

Rotate 30 CCW (Rotar 30 izquierda)
Rota la vista de cámara 30 grados a la
izquierda, como una mesa de animación.

View > Rotate View CCW
(Ver > Rotar 30 izquierda)

Toggle Quick Close-up (Alternar primer
plano rápido)

Use la herramienta Magnifier (Lupa) para
centrar la imagen rápidamente en la
posición del ratón y acercarla un valor
predefinido, como 4X. A continuación,
puede alejarla de nuevo. Mantenga
pulsada la tecla Mayús y pulse Z para
acercar y para volver a alejar. Sustituya
el restablecimiento de zoom pulsando
Mayús +.

El área en el que acerca o aleja la imagen
depende de la ubicación del puntero en la
vista de cámara. Si aleja la imagen y
después mueve el puntero a una
ubicación distinta al alejar el ratón, la
imagen se centrará en esa ubicación.

NOTA: Si utiliza una tableta o un trackpad que admita función táctil, también puede utilizar los gestos de dos dedos
estándar para zoom, rotación y paneo en las vistas de cámara y dibujo.
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Capítulo 5: Cómo dibujar
Una vez iniciado Toon Boom Harmony, puede comenzar a dibujar inmediatamente utilizando la capa de dibujo
predeterminada.

Cómo dibujar

1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel) o pulse Alt +
B.

2. En la vista de línea de tiempo o de carta de exposición, haga clic en la primera celda de la capa de dibujo.

3. En la vista de dibujo o de cámara, comience a dibujar.

4. Para seleccionar un color distinto, en la vista de color, seleccione una muestra de color distinta. Haga doble
clic en la muestra de color para abrir la ventana Colour Picker (Selector de color) y cambiar el color. Recuerde
que todo lo que ya esté pintado con dicho color se actualizará al nuevo.

17
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Capítulo 6: Cómo pintar

Toon Boom Harmony incluye algunas funciones de coloreado muy útiles a la hora de pintar. Para pintar los dibujos,
utilizará distintas muestras de color, a diferencia de otros programas de pintado en los que modifica la muestra
principal cada vez que desea pintar con un color diferente.

En la vista de color, seleccione una muestra de color distinta para cada color que desee pintar en el dibujo. Puede
agregar todas las muestras de color que desee. También puede cambiar el nombre a las existentes y modificarlas.

Cuando modifique el color de una muestra de color existente, actualiza automáticamente todas las zonas pintadas
con esta muestra en todo el proyecto. La muestra de color tiene un número de ID exclusivo que la asocia con las
zonas pintadas. De este modo, puede cambiar el aspecto del personaje en cualquier momento sin necesidad de
volver a pintarlo.

En animación se utilizan colores específicos para pintar cada personaje específico. Con el fin de mantener una
coherencia absoluta, se crea una paleta de colores para cada personaje, prop y efecto de la producción. A esto se le
denomina paleta maestra.
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Capítulo 6: Cómo pintar

Las paletas maestras contienen una muestra de color para cada zona que se debe colorear con un valor de color
RGBA preciso.

El uso de una paleta de colores maestra tiene muchas ventajas, entre otras:

• Cada personaje conserva permanentemente sus colores específicos.

• No puede usar por error un color que no esté en la paleta maestra.

• Estandarización y coherencia del color durante la producción

• Varios artistas pueden usar la misma paleta de colores y generar los mismos resultados.

Toon Boom Harmony utiliza paletas para mantener todos los colores necesarios para pintar los elementos,
permitiendo un control y coherencia totales del proceso de pintado.

Una paleta se crea asignando un conjunto de colores a cada personaje, prop o efecto. Creará una nueva paleta y
agregará un nuevo color, conocido como muestra de color, para cada zona del personaje, como piel, pelo, lengua,
camiseta, pantalones, etc.

Cómo pintar dibujos

1. En la vista de línea de tiempo o de carta de exposición, seleccione el dibujo que desea pintar.

2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Paint (Pintar) o pulse Alt
+ I.

3. En la vista de color, seleccione una paleta.

4. Seleccione un color de la paleta.

‣ Si trabaja con capas de vectores, haga doble clic en la muestra de color para abrir la ventana Colour
Picker (Selector de color) y modificar el color.

‣ Si trabaja con capas de mapa de bits, utilice los controles RGB/HSV para seleccionar un color.
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NOTA: La paleta de colores solo aparece en la vista de color al seleccionar un elemento de dibujo.

5. En la vista de dibujo o de cámara, comience a pintar el dibujo con los colores.

Cierre de huecos
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Capítulo 6: Cómo pintar

Al pintar, tenga en cuenta que algunas de las áreas de su dibujo no están cerradas. Para cerrar la zona, puede
dibujar la línea que falta con las herramientas Brush (Pincel) o Pencil (Lápiz ), o bien cerrar el hueco con una línea
invisible. Para ello, se utiliza la herramienta Close Gap (Cerrar hueco).

La herramienta Close Gap (Cerrar hueco) permite cerrar huecos pequeños en un dibujo. La herramienta Paint
(Pintar) solo pinta áreas cerradas. La herramienta Close Gap (Cerrar hueco) permite crear pequeñas pinceladas
invisibles entre los dos puntos más cercanos para cerrar la zona de color. No es necesario que realice el trazo
directamente sobre el hueco. Puede dibujarlo con varios milímetros de separación y la herramienta Close Gap
(Cerrar hueco) elegirá automáticamente los dos puntos más cercanos y cerrará el hueco.

Uso de la herramienta Close Gap (Cerrar hueco)

1. Realice una de las siguientes acciones:

‣ En la barra de herramientas Tools (Herramientas), seleccione la herramienta Close Gap (Cerrar hueco)
.

‣ En el menú superior, seleccione Drawing > Drawing Tools > Close Gap (Dibujo > Herramientas de
dibujo > Cerrar hueco).

‣ Pulse Alt + C.

2. En la vista de propiedades de la herramienta, pulse el botón Auto-Flatten (Acoplamiento automático)
si desea que la pincelada que ha dibujado quede acoplada en el dibujo en lugar de permanecer sobre el
mismo.

3. Puede mostrar líneas invisibles seleccionando View > Show > Show Strokes (Ver > Mostrar > Mostrar
pinceladas) o pulse K. Si no muestra las pinceladas, aparecerá un cuadro de mensaje.

Seleccione la opción Don’t Show This Message Again (No volver a mostrar este mensaje) para impedir
que vuelva a aparecer este cuadro de mensaje.

4. En la vista de cámara o de dibujo , trace una línea invisible cerca del hueco que se va a cerrar.

El hueco se cierra automáticamente.
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Capítulo 7: Creación de una animación tradicional

El primer paso para completar una animación sin papel tradicional es la creación de un boceto, que es el esqueleto
de la animación. Habitualmente, comenzaría con la acción principal. Por ejemplo, para animar un ciclo de andar,
comenzará por el movimiento del torso y de las piernas. La cabeza, brazos y ropa se agregarán más adelante
durante la animación secundaria.

Para conseguir una animación satisfactoria, complete la acción principal antes de agregar todos los detalles. Si
comienza a animar todos los detalles inmediatamente, perderá mucho tiempo en caso de tener que realizar
correcciones. Con frecuencia, la animación parecerá demasiado rígida.

Cómo animar

1. Pulse Ctrl + U (Windows/Linux) o ⌘ + U (Mac OS X) para abrir el cuadro de diálogo Preferences (Pre-
ferencias).

2. Seleccione la pestaña Exposure Sheet (Carta de exposición).

3. Seleccione la opción Use Current Frame as Drawing Name (Usar fotograma actual como nombre de
dibujo). Cuando esta preferencia esté activada, los dibujos tendrán el mismo nombre que el fotograma en el
que se hayan creado (número de fotograma).

4. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel) o pulse Alt +
B.

5. En la vista de color, seleccione un color para el pincel. Es una buena idea elegir un color claro para el boceto
de animación. Servirá de ayuda en la siguiente tarea, el proceso de clean up.
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Capítulo 7: Creación de una animación tradicional

6. En la vista de línea de tiempo o de carta de exposición, seleccione la celda en la que desea que aparezca
el primer dibujo.

7. En la vista de cámara o de dibujo, dibuje el primer dibujo clave.

8. Con la primera celda aún seleccionada, realice una de las siguientes acciones para marcar el dibujo como
dibujo clave. Esto le ayudará a mantener el orden.

‣ En la barra de herramientas Mark Drawing (Marcar dibujo), haga clic en el botón Mark Selected
Drawings as Key (Marcar dibujo como dibujo clave) .

‣ En la vista de carta de exposición, seleccione Drawings > Mark Drawing As > Key Drawing
(Dibujos > Marcar dibujo como > Dibujo clave).

‣ En la vista de línea de tiempo, seleccione Drawings > Mark Drawing As > Key Drawing (Dibujos >
Marcar dibujo como > Dibujo clave).

9. En la barra de herramientas Tools (Herramientas), haga clic en el botón Onion Skin (Papel cebolla) . La
función Onion Skin (Papel cebolla) muestra los dibujos anterior y siguiente como referencias visuales para
ayudarle a dibujar su nueva pose.
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10. En la vista de línea de tiempo, haga clic y arrastre los marcadores azules de papel cebolla para ampliar el
número de dibujos visibles anteriores y siguientes.

11. En la barra de herramientas Camera View (Vista de cámara) o Drawing View (Vista de dibujo), pulse Reduce
One Next/Previous Drawing (Reducir un dibujo anterior/siguiente) o Add One Next/Previous Drawing (Agre-
gar un dibujo siguiente/anterior) de papel cebolla para reducir o aumentar el número de dibujos visibles ante-
riores y posteriores. Los iconos rojos corresponden a los dibujos anteriores y los iconos verdes

a los posteriores.

12. En la vista de línea de tiempo o de carta de exposición, seleccione la celda en la que desea que aparezca el
próximo dibujo clave.

13. En la vista de cámara o de dibujo, dibuje el segundo dibujo clave.

14. En la vista de carta de exposición o de línea de tiempo, identifique el dibujo como dibujo clave.

15. En la vista de línea de tiempo o de carta de exposición, seleccione una celda entre los dos dibujos clave.
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Capítulo 7: Creación de una animación tradicional

16. En la vista de línea de tiempo, haga clic en Create Empty Drawing (Crear dibujo vacío) para crear un
dibujo vacío o pulse Alt + Mayús + R.

‣ En la vista de carta de exposición, haga clic con el botón derecho y seleccione Drawings > Create
Empty Drawing (Dibujos > Crear dibujo vacío) o pulse Alt + Mayús + R.

NOTA: En lugar de crear un dibujo vacío, puede comenzar a dibujar directamente.

17. En la vista de cámara o de dibujo, dibuje la nueva pose.

18. Si es necesario, en la vista de carta de exposición o de línea de tiempo, identifique el nuevo dibujo como
un nuevo dibujo clave, de descomposición o intercalado mediante la barra de herramientas Mark Drawing
(Marcar dibujo).
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19. Utilice las barras de herramientas Flip (Hojear) y Easy Flipping (Flipping sencillo) para revisar la animación.

20. En la vista de línea de tiempo o de carta de exposición, seleccione una nueva celda y repita los pasos ante-
riores para cada nuevo dibujo.

21. En la vista de línea de tiempo, utilice los botones Enable/Disable All (Activar/desactivar todo) y Solo
para desactivar todas las capas que no desee ver durante la reproducción.

22. Para reproducir en bucle, mueva el cabezal de reproducción rojo al fotograma de inicio que desee y haga clic
en el botón Start (Iniciar) de la barra de herramientas Timeline (Línea de tiempo). Mueva el cabezal al último
fotograma de la reproducción y haga clic en el botón Stop (Detener).

23. En la barra de herramientas Playback (Reproducir), haga clic en el botón Loop (Bucle) para iniciar la repro-
ducción.

24. En la barra de herramientas Playback (Reproducir), haga clic en el botón Play (Reproducir) para iniciar la
animación.

Limpieza
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Capítulo 7: Creación de una animación tradicional

Una vez que se haya completado el boceto de animación, es el momento de limpiarlo y tintarlo. A este paso
también se le denomina trazado. Consiste en trazar líneas sólidas y limpias sobre el boceto de animación para
cerrar las zonas abiertas. Es el paso final de la animación sin papel antes del paso de ink and paint.

Deberá agregar una nueva capa de dibujo para el dibujo limpio. Equivale a agregar una hoja de papel y trazar el
boceto utilizando el disco de animación. Este método permite mantener los bocetos y los dibujos limpios
intactos. Solo debe desactivar la capa de boceto para impedir que aparezca en la escena.

Si tiene pensado trazar la animación en la vista de dibujo, puede activar la mesa de luz para mostrar todas las
capas en el proyecto.

Trazado de la animación en una nueva capa

1. En la vista de línea de tiempo, haga clic en el botón Add Drawing Layer (Agregar capa de dibujo) o
pulse Ctrl + R (Windows/Linux) o ⌘ + R (Mac OS X).

Se abre la capa Add Drawing Layer (Agregar capa de dibujo).

2. En el campo Name (Nombre), escriba el nombre de la nueva capa.

3. Establezca las opciones Line Art (Capa de líneas) y Colour Art (Capa de color) en Vector para obtener una
capa de vectores o en Bitmap (Mapa de bits) para tener una capa de mapa de bits.

4. Realice una de las siguientes acciones:

‣ Haga clic en Add (Agregar) para agregar una primera capa y mantener la ventana abierta para agregar
más capas.

‣ Haga clic en Add and Close (Agregar y cerrar) para agregar una nueva capa y cerrar la ventana.

Se agrega a la vista de línea de tiempo una nueva capa de dibujo.

5. En la vista de línea de tiempo, haga clic en el icono Lock (Bloquear) de la capa que contiene el boceto
de animación para impedir que dicha capa se pueda seleccionar en la vista Camera (Cámara).

6. En la vista de línea de tiempo o de carta de exposición, seleccione la celda de la nueva capa que corres-
ponda al primer dibujo clave del boceto de animación.

7. En la barra de herramientas Tools (Herramientas), seleccione una herramienta de dibujo, como la herra-
mienta Pencil (Lápiz)
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.

8. En la vista de color, seleccione un color para trazar la animación. Seleccione un color oscuro intenso, como
el negro, para asegurarse de conseguir un contraste adecuado con el color claro del boceto de animación.

9. En la vista de cámara o de dibujo, comience a trazar el primer dibujo clave.

10. Si tiene otras capas en medio, puede desactivarlas temporalmente en la vista de línea de tiempo, de modo
que únicamente se muestren el boceto de animación y la capa de clean up en la vista de cámara.

11. En la barra de herramientas Tools (Herramientas), haga clic en el botón Enable Onion Skin (Activar papel
cebolla) .

12. Si no utiliza la opción Onion Skinning by Drawing (Usar papel cebolla mediante dibujo), extienda el rango de
papel cebolla en la vista de línea de tiempo; en caso contrario, utilice los botones Add One Previous Drawing
(Agregar un dibujo anterior) y Add One Next Drawing (Agregar un dibujo siguiente) de papel cebolla en la barra
de herramientas de dibujo o de vista de cámara para agregar dibujos a la vista de papel cebolla.

13. En la vista de línea de tiempo o de carta de exposición, seleccione la siguiente celda que corresponde a un
boceto de dibujo.

14. En la vista de cámara, trace el siguiente dibujo.
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15. Repita los pasos anteriores para cada dibujo.
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Capítulo 8: Aplicación de morphing a dibujos

Cuando se trata de morphing, deberá practicar y adquirir soltura con esta función. Una vez que esté familiarizado
con las reglas básicas, puede comenzar a crear secuencias de morphing. Para comenzar, utilice elementos
sencillos. Cuando tenga la suficiente confianza con el proceso de morphing, puede comenzar a usar técnicas de
morphing complejas y avanzadas, como rotaciones de cabeza o de personajes completos.

Puede que desee eliminar una secuencia de morphing completa para rehacer una secuencia desde el principio.

Creación de un elemento de morphing básico

1. En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add Drawing Layer (Agregar
capa de dibujo) para agregar una nueva capa al proyecto.

2. Cambie el nombre de la nueva capa (por ejemplo, Morphing).

3. En la vista de línea de tiempo o de carta de exposición, seleccione la primera celda de la capa.

4. Realice una de las siguientes acciones:

‣ En la barra de herramientas Tools (Herramientas), seleccione la herramienta Rectangle (Rectángulo)
.

‣ Pulse Alt + 7.

5. En la vista de cámara o de dibujo, dibuje un rectángulo.

6. Realice una de las siguientes acciones o ambas:

‣ Mantenga pulsada la tecla Mayús para dibujar un cuadrado.

‣ Mantenga pulsada la tecla Alt para dibujar un rectángulo a partir de su centro.

7. Pinte el rectángulo con la herramienta Paint (Pintar).
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8. En la vista de carta de exposición o de línea de tiempo, vaya a la celda en la que desea que termine la
secuencia de morphing.

9. Realice una de las siguientes acciones:

‣ En la barra de herramientas Tools (Herramientas), seleccione la herramienta Ellipse (Elipse) .

‣ Pulse Alt + =.

10. Dibuje y pinte la elipse utilizando el mismo color de contorno que en el rectángulo.

11. En la vista de carta de exposición o de línea de tiempo, seleccione el primer fotograma y todos los foto-
gramas hasta el último incluido, que es el dibujo de rectángulo.

12. Realice una de las siguientes acciones:

‣ En el menú superior, seleccione Animation > Morphing > Create Morphing (Animación > Morphing
> Crear morphing).

‣ En la vista de carta de exposición o de línea de tiempo, haga clic con el botón derecho y seleccione
Morphing > Create Morphing (Morphing > Crear Morphing).

‣ Pulse Alt + M.
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Aparecen flechas entre los dos dibujos clave para mostrar que se han creado intercalados generados por
ordenador.

NOTA: Utilice la barra de herramientas Playback (Reproducir) para reproducir la secuencia de morphing. Para
desplazarse por los intercalados, alterne entre coma ( , ) y punto ( . ). Pulse F4 para alternar entre los dos dibujos
clave.

Eliminación de una secuencia de morphing completa

1. En la vista de carta de exposición o de línea de tiempo, seleccione una celda en la secuencia de morphing.

2. Realice una de las siguientes acciones:

‣ En el menú superior, seleccione Animation > Morphing > Delete Morphing (Animación > Morphing >
Eliminar morphing).

‣ En la vista de carta de exposición o de línea de tiempo, seleccione Morphing > Delete Morphing
(Morphing > Eliminar Morphing).

‣ Haga clic con el botón derecho en la secuencia y seleccione Morphing > Delete Morphing (Morphing >
Eliminar Morphing).

Se quita toda la secuencia entre los dos fotogramas clave.
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Capítulo 9: Importación de imágenes de mapa de bits
Una imagen de mapa de bits es una imagen compuesta por píxeles que dependen tanto del tamaño como de la
resolución. En Harmony, puede importar imágenes de mapa de bits y vectorizarlas para poder editarlas. A
continuación, puede utilizar distintas herramientas de dibujo para editar la imagen. También puede conservar la
imagen de mapa de bits tal cual.

También puede importar imágenes en capas de mapa de bits o vectores en función del proyecto.

NOTA: Un modo rápido de importar una imagen de mapa de bits es arrastrar y colocar la imagen de mapa de bits
directamente desde la librería en la escena (cámara). Sin embargo, no tendrá acceso a todas las opciones de
importación.

Apertura del cuadro de diálogo Import Images (Importar imágenes)

1. Realice una de las siguientes acciones:

‣ En el menú superior, seleccione File > Import > Images (Archivo > Importar > Imágenes).

‣ En la barra de herramientas File (Archivo), haga clic en el botón Import Images (Importar imágenes) .

‣ En la vista de carta de exposición, haga clic con el botón derecho en cualquier parte del área de
fotogramas y seleccione Import > Images (Importar > Imágenes).

Se abre el cuadro de diálogo Import Images (Importar imágenes).

Importación de una imagen de mapa de bits en su formato original

1. En la sección Files (Archivos) del cuadro de diálogo Import Images (Importar imágenes), haga clic en
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Browse (Examinar) para buscar y seleccionar una o más imágenes en el ordenador.

2. Decida si la imagen de mapa de bits se incluirá en una nueva capa o en una capa existente. Para agregar
la imagen de mapa de bits a una nueva capa, vaya al paso 3. Para agregar la imagen de mapa de bits a
una capa existente, vaya al paso 4.

3. Agregue la imagen de mapa de bits a una nueva capa seleccionando la opción Create Layer(s) (Crear
capas) y una de las siguientes opciones. A continuación, continúe con el paso 5:

‣ Create Single Layer Named (Crear una sola capa con nombre): Crea una capa a la que puede
asignar un nombre.

‣ Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo): Crea una
capa basada en cada prefijo de nombre de archivo único. Por ejemplo, los nombres de archivo a-1.tga,
a-2.tga y b-1.tga crearán capas llamadas "a" y "b," donde "a" tiene dos dibujos y "b" uno. Al crear una
sola capa a partir de estos tres nombres de archivos, los tres dibujos se insertarán en la capa creada.

4. Seleccione la opción Add to Existing Layer (Agregar a capa existente) para colocar la imagen de mapa
de bits en una capa que seleccione de la lista. Si solo hay disponibles capas de vectores en la escena, no
se mostrarán en la lista. Puede elegir encapsular el mapa de bits en un símbolo seleccionando la opción
Create Symbols for Imported Items (Crear símbolos para elementos importados).

5. En la sección Import Options (Opciones de importación), seleccione la opción Keep As Original Bitmap
(Mantener como mapa de bits original). En la sección Alignment (Alineación), decida el tamaño y la posi-
ción de la imagen dentro del encuadre de cámara. Según la configuración de la escena (la altura y la
anchura en píxeles que elija para el proyecto), una imagen importada se puede escalar hasta el punto en el
que sean visibles todos los píxeles individuales. La sección Alignment (Alineación) cuenta con tres opcio-
nes:

Parámetro Descripción

Fit (Ajustar)

Aumenta o reduce (pero no distorsiona) la altura de la imagen
para que se ajuste a la altura total de la cuadrícula de la escena.

Si la orientación de la imagen es horizontal, aumenta o reduce
(pero no distorsiona) la anchura de la imagen para que se ajuste
a la de la cuadrícula de la escena.
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Tenga en cuenta que la regla de alineación Fit (Ajustar) es igual
que la regla Center Fit (Ajuste centro) de las propiedades de la
capa.

Pan (Panear)

Es lo opuesto al parámetro Fit (Ajustar). Si la orientación de la
imagen es vertical, su anchura se ajustará a la cuadrícula de la
escena. Como resultado, parte de la altura de la imagen
rebasará la altura del fotograma. Esto puede ser útil si desea que
el fondo se mueva hacia arriba y hacia abajo, o de izquierda a
derecha para que parezca como si la cámara estuviese
paneando o que realmente se realice un paneo de cámara.

Lo opuesto se aplicaría a una imagen horizontal. Su altura se
ajustará a la cuadrícula de la escena, por lo que es posible que la
imagen rebase los límites de la cuadrícula de la escena.
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Tenga en cuenta que la regla de alineación Pan (Panear) es igual
que la regla Center First Page (Centrar primera página) de las
propiedades de la capa.

Project Resolution (Reso-
lución del proyecto)

Escala la imagen proporcionalmente a la resolución de la
escena. El sistema toma la resolución de la imagen de mapa de
bits, por ejemplo, 4000 x 2000 y, a continuación, la compara con
la resolución de la escena, por ejemplo 1920 x 1080, y ajusta el
factor de escala proporcionalmente. Por lo tanto, en este
ejemplo el mapa de bits aparecería al 208 % (4000/1920). Si
importa un mapa de bits de 960 x 540, se mostrará al 50 %
(960/1920) del tamaño de la resolución del proyecto.

Tenga en cuenta que la regla de alineación Project Resolution
(Resolución del proyecto) es igual que la regla As Is (Tal cual) de
las propiedades de la capa.

6. En la sección Transparency (Transparencia), seleccione una de las siguientes opciones en el menú Alpha
(Alfa):

Parámetro Descripción

Premultiplied with White
(Premultiplicado con blanco)

Los píxeles individuales del borde de una imagen se mezclan
con blanco.

Premultiplied with Black
(Premultiplicado con negro)

Los píxeles semitransparentes de la imagen original se mezclan
con negro.

Straight (Recto)
Los píxeles del borde de una imagen se mezclan con negro,
blanco y grises.

Clamp Colour to Alpha (Fijar
color a alfa)

Premultiplica el valor de color con el valor de alfa. Cuando el
color se fija al alfa, el valor de color no puede ser mayor que el
valor de alfa. Calcula el valor de color real más rápido. Cuando
los valores de RGB se multiplican con el valor de alfa, por
ejemplo, si tiene un píxel con el valor R=247, G=188, B=29 y el
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alfa es del 50 % o la imagen tiene una transparencia del 50 %,
los valores de RGB reales que se generan serían la mitad de las
cantidades indicadas.

7. Haga clic en OK (Aceptar).

Importación de una imagen de mapa de bits como un dibujo de mapa de bits de Toon Boom

1. En la sección Files (Archivos) del cuadro de diálogo Import Images (Importar imágenes), haga clic en Bro-
wse (Examinar) para buscar y seleccionar una o más imágenes en el ordenador.

2. En la sección Import Options (Opciones de importación), seleccione la opción Import asToon Boom Bitmap
Drawing (Importar como dibujo de mapa de bits de Toon Boom).

3. Decida si la imagen de mapa de bits se incluirá en una nueva capa o en una capa existente. Para agregar la
imagen de mapa de bits a una nueva capa, vaya al paso 4. Para agregar la imagen de mapa de bits a una
capa existente, vaya al paso 5.

4. En la sección Layer (Capa), seleccione la opción Create Layer (Crear capa) y una de las siguientes opcio-
nes para agregar la imagen de mapa de bits a una nueva capa:

‣ Create Single Layer Named (Crear una sola capa con nombre): crea una capa a la que puede asignar
un nombre.

‣ Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo): crea una capa
basada en cada prefijo de nombre de archivo único. Por ejemplo, los nombres de archivo a-1.tga, a-2.tga
y b-1.tga crearán capas llamadas "a" y "b," donde "a" tiene dos dibujos y "b" uno. Al crear una sola capa a
partir de estos tres nombres de archivos, los tres dibujos se insertarán en la capa creada.

5. Seleccione la opción Add to Existing Layer (Agregar a capa existente) para colocar la imagen de mapa de
bits en una capa que seleccione de la lista. Si solo hay disponibles capas de vectores en la escena, no
se mostrarán en la lista. Puede elegir encapsular el mapa de bits en un símbolo seleccionando la opción
Create Symbols for Imported Items (Crear símbolos para elementos importados).

6. En la sección Alignment (Alineación), decida el tamaño y la posición de la imagen dentro del encuadre de
cámara. Según la configuración de la escena (la altura y la anchura en píxeles que elija para el proyecto), una
imagen importada se puede escalar hasta el punto en el que sean visibles todos los píxeles individuales.

NOTA: Asegúrese de estar en el modo Render de la vista de cámara al juzgar una imagen mejorada;
de lo contrario, puede aparecer difuminada. También puede ajustar la calidad de una imagen de
mapa de bits mostrada en el modo OpenGL mediante View > Bitmap File Quality (Vista > Calidad del
archivo de mapa de bits). Debe seleccionar la imagen de mapa de bits utilizando la herramienta
Transform (Transformar).

Se encuentran disponibles las tres opciones de reglas de alineación siguientes:
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Parámetro Descripción

Vertical Fit (Ajuste ver-
tical)

Aumenta o reduce (sin distorsión) la altura de la imagen para que se
ajuste a la altura total del fotograma de la escena (cuadrícula de
alineación).

Horizontal Fit (Ajuste hori-
zontal)

Aumenta o reduce (sin distorsión) la anchura de la imagen para que se
ajuste a la anchura total del fotograma de la escena (cuadrícula de
alineación).

Actual Size (Tamaño
real)

Escala la imagen proporcionalmente a la resolución de la escena. El
sistema toma la resolución de la imagen de mapa de bits, por ejemplo,
4000 x 2000 y a continuación, la compara con la resolución de la
escena, por ejemplo 1920 x 1080, y ajusta el factor de escala
proporcionalmente. Por lo tanto, en este ejemplo el mapa de bits
aparecería al 208 % (4000/1920). Si importa un mapa de bits de 960 x
540, se mostrará al 50 % (960/1920) del tamaño de la resolución del
proyecto.

7. En la sección Transparency (Transparencia) decida cómo desea que se suavice la imagen de mapa de
bits, en concreto, la forma en que los píxeles a lo largo del borde se mezclan en los canales RGBA (rojo,
verde, azul, alfa (transparente)). La imagen de mapa de bits existirá en la capa de mapa de bits del ele-
mento de dibujo que se acaba de crear.
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Parámetro Descripción

Premultiplied with White
(Premultiplicado con blanco)

Los píxeles individuales del borde de una imagen se mezclan con
blanco.

Premultiplied with Black
(Premultiplicado con negro)

Los píxeles individuales del borde de una imagen se mezclan con
negro.

Straight (Recto)
Los píxeles del borde de una imagen se mezclan con negro, blanco
y grises.

8. Haga clic en OK (Aceptar).

Importación de una imagen de mapa de bits y conversión a dibujo de vector de Toon Boom

1. En la sección Files (Archivos) del cuadro de diálogo Import Images (Importar imágenes), haga clic en Bro-
wse (Examinar) para seleccionar una o más imágenes en el ordenador.

2. En la sección Import Options (Opciones de importación), seleccione la opción Convert to Toon Boom Vec-
tor Drawing (Convertir a dibujo de vector de Toon Boom).

3. Decida si la imagen de mapa de bits se incluirá en una nueva capa o en una capa existente. Para agregar la
imagen de mapa de bits a una nueva capa, vaya al paso 4. Para agregar la imagen de mapa de bits a una
capa existente, vaya al paso 5.

4. En la sección Layer (Capa), seleccione la opción Create Layer (Crear capa) y una de las siguientes opcio-
nes para agregar la imagen de mapa de bits a una nueva capa:

‣ Create Single Layer Named (Crear una sola capa con nombre): Crea una capa a la que puede asignar
un nombre.

‣ Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo): Crea una capa
basada en cada prefijo de nombre de archivo único. Por ejemplo, los nombres de archivo a-1.tga, a-2.tga
y b-1.tga crearán capas llamadas "a" y "b," donde "a" tiene dos dibujos y "b" uno. Al crear una sola capa a
partir de estos tres nombres de archivos, los tres dibujos se insertarán en la capa creada.

5. Seleccione la opción Add to Existing Layer (Agregar a capa existente) para colocar la imagen de mapa de
bits en una capa que seleccione de la lista. Si solo hay disponibles capas de vectores en la escena, no
se mostrarán en la lista. Puede elegir encapsular el mapa de bits en un símbolo seleccionando la opción
Create Symbols for Imported Items (Crear símbolos para elementos importados).

6. En la sección Vectorization (Vectorización), decida si desea importar la imagen en blanco y negro o en gri-
ses.
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Parámetro Descripción

Black and White (Blanco y
negro)

Vectoriza los dibujos como una línea negra sólida; crea un dibujo
100 % basado en vectores.

Grey (Gris)

Vectoriza la imagen como una mezcla de contorno vectorial y
relleno de mapa de bits en escala de grises. Las líneas con-
servan la textura de la digitalización y el blanco del papel pasa a
ser transparente.
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Capítulo 10: Creación de un personaje Cut-out

Se pueden emplear muchas técnicas para descomponer una marioneta. En esta sección, aprenderá uno de los
métodos más comunes y sencillos. Para la primera descomposición de personaje, siga estas instrucciones para
hacerse una idea de cómo funciona Harmony. Una vez que conozca las funciones y comandos básicos de
Harmony, podrá crear sus propias técnicas para cumplir las necesidades de su producción.

Dibujo de las piezas

La técnica de descomposición principal que se muestra es el trazado del modelo.

Descomposición de un personaje

1. En la vista de línea de tiempo, añada una nueva capa de dibujo para cada parte del cuerpo que desee separar.
Puede pulsar Ctrl + R (Windows/Linux) o ⌘ + R (Mac OS X).

2. En la vista de línea de tiempo, seleccione la primera celda de la capa en la que desea dibujar la parte.
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3. En la barra de herramientas Tools (Herramientas), seleccione una herramienta de dibujo.

4. En la vista de color, seleccione una muestra de color. Si todavía no ha creado ninguna paleta para el per-
sonaje, consulte Cómo pintar en la página 19.

5. En la vista de cámara o de dibujo, dibuje la nueva parte con el menor número de puntos posibles, de modo
que las piezas se puedan manipular, modificar o volver a dibujar fácilmente. Este proceso puede ser más
fácil con la herramienta Polyline (Polilínea) .

Si trabaja en la vista de dibujo, haga clic en el botón Light Table (Mesa de luz) de la barra de
herramientas Drawing View (Vista de dibujo) para mostrar las demás capas y colores lavados. También
puede pulsar Mayús + L.

6. Puede utilizar la herramienta Stroke (Línea vectorial transparente) de la barra de herramientas Tools (Herra-
mientas) para crear una fina línea invisible si desea cerrar una forma sin dibujar la pincelada real.

‣ Seleccione View > Show > Show Strokes (Ver > Mostrar > Mostrar líneas vectoriales transparentes)
o pulse K para mostrar las líneas invisibles.

7. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Paint (Pintar) o pulse
Paint Unpainted (Pintar despintado) para colorear el dibujo.

8. En la vista de color, seleccione el color correspondiente.

9. En la vista de cámara o de dibujo, pinte el dibujo.
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10. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Select (Seleccionar) . Selec-
cione el dibujo y acople las líneas haciendo clic en el botón Flatten (Acoplar) de la vista de propiedades
de la herramienta.

11. Si las líneas están compuestas por varias pinceladas de lápiz, puede que desee combinarlas en una única
línea de lápiz fluida. Mediante la herramienta Select (Seleccionar), seleccione las líneas de lápiz que se
deben combinar y, en la vista de propiedades de la herramienta, haga clic en la herramienta Merge Pencil
Lines (Combinar líneas de lápiz) .

12. Repita todo el proceso hasta terminar la descomposición.
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Adición de pegs

Se recomienda agregar pegs padres a las capas de dibujo, que son capas de ruta que permiten agregar
fotogramas clave para modificar las posiciones de las piezas a lo largo del tiempo. No es obligatorio, pero sí útil
que los dibujos y los fotogramas clave estén separados.

Cómo emparentar pegs a capas de dibujo

1. En la vista de línea de tiempo, seleccione todas las capas.
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2. En la barra de herramientas Timeline Layer (Capa de línea de tiempo), haga clic en el botón Add Parent Peg
(Agregar peg padre) para agregar un peg padre a todas las capas seleccionadas.

s

En este punto, en la vista de nodos, las capas parecen enredadas.

3. En la vista de nodos, seleccione todos los nodos y, en la barra de herramientas Network View (Vista de red),
haga clic en el botón Order Network Down (Orden de red descendente) .

47



Capítulo 10: Creación de un personaje Cut-out

Cómo emparentar capas

Harmony permite extender las técnicas de rigging más allá de los límites normales y establece nuevas normas.
Puede crear jerarquías sin encapsular piezas unas dentro de otras mediante la creación de una estructura
vinculada entre capas.

Debe crear una jerarquía en los brazos y piernas, y mantenerlos separados del cuerpo. Así contará con más
libertad en la animación y cuando tenga que escalar o sesgar el torso, no afectará a todo el cuerpo.

Creación de una jerarquía en la vista de línea de tiempo

1. Arrastre la pieza hija (mano) y colóquela SOBRE la pieza padre (antebrazo). A continuación, puede arras-
trar la pieza padre (antebrazo) sobre otra pieza padre (brazo superior).
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‣ Puede desconectar una capa de su capa padre manteniendo presionada la tecla Mayús y arrastrando la
capa padre lejos de la capa hija. Coloque los seleccionados entre las otras capas.

Creación de una jerarquía en la vista de nodos

‣ Sin pegs: desde la parte padre, arrastre una nueva conexión de cable desde el puerto de salida del nodo
(inferior) y conéctela al puerto de entrada del nodo de la parte hija (superior).

‣ Con pegs: desde el peg de la parte padre, arrastre una nueva conexión de cable desde el puerto de salida
del nodo (inferior) y conéctela al puerto de entrada del peg de la parte hija (superior).
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Peg maestro

Cuando anime el personaje, es probable que deba cambiar el tamaño y cambiarlo de posición para que encaje en
la escena. Cuando tenga que reducir o mover el personaje, es una buena idea enganchar (conectar) toda la
marioneta a una trayectoria.

Al conectar la marioneta a un peg, podrá escalarla y cambiarla de posición sin tener que hacerlo en las distintas
partes y piezas. Solo una capa contendrá la información de posición, lo que facilita la modificación y el control de
la animación.

Adición de un peg maestro

1. En la vista de línea de tiempo, seleccione la capa superior para que quede emparentada a un peg. Debe
seleccionar una capa para poder agregar un peg a la escena. A menos que utilice el modo Display All (Mos-
trar todo) del peg Display (Visualización), obtendrá un mensaje de error si intenta agregar un peg sin rea-
lizar ninguna selección.

2. En la vista de línea de tiempo, haga clic en el botón Add Peg (Agregar peg) .

Se agrega a la línea de tiempo un nuevo peg al que queda emparentada la capa seleccionada.

3. Asigne el nombre Master más el nombre del personaje al nuevo peg.

4. En la vista de línea de tiempo, seleccione todas las capas que desee conectar al nuevo peg. Recuerde
que dicho peg ya tiene un elemento padre.

5. Arrastre la selección SOBRE la capa del peg para emparentar todas las piezas del personaje al peg. Si se
agregan capas encima de las capas que ya tienen padres, mueva dicha capa con padres de nuevo a la
parte superior de la pila de capas.

50



Harmony 14.0 Premium - Guía de introducción

51



Harmony 14.0 Premium - Guía de introducción (servidor)

52



Harmony 14.0 Premium - Guía de introducción

Capítulo 11: Uso de deformadores
La tecnología de deformación permite deformar dibujos de mapa de bits y vectoriales durante un periodo de tiempo.
Puede vincular deformadores para crear una jerarquía de deformación. Puede deformar un personaje compuesto por
una o varias capas de dibujo o imagen, y hacer que se mueva como si fuese una marioneta Cut-out. Esto también
permite tomar un área de una única imagen de mapa de bits y crear una animación por distorsión.

Acerca de los efectos de deformación

Las deformaciones permiten animar un gráfico de mapa de bits o vectorial, incluidos los gradientes y texturas. Las
deformaciones actúan como un esqueleto con miembros y articulaciones que puede doblar, cambiar de forma y
curvar. Puede deformar un personaje compuesto por una o varias capas de dibujo o imagen, y hacer que se mueva
como si fuese una marioneta Cut-out. Esto también permite tomar un área de una única imagen de mapa de bits y
crear una animación por distorsión. Un esqueleto de deformación está compuesto por nodos de deformación, que
son las distintas piezas (representadas aquí como capas o nodos) necesarias para articular o deformar los dibujos,
como una serie de huesos, curvas o huesos de juego (consulte ).

Deformador de huesos

La deformación de hueso permite crear una estructura de esqueleto en la que el hueso padre mueva el hijo. La
deformación de hueso resulta útil al animar las extremidades de un personaje, como los brazos o las piernas,
agregando fluidez y naturalidad a la animación. Se puede manipular para rotar un miembro en una articulación y
también para acortar o alargar las extremidades de un miembro. También es muy práctica para doblar el torso.

NOTA: Si está creando un rig para utilizarlo en un juego, utilice la deformación Game Bone (Hueso de juego).
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Deformador de hueso de juego

La deformación de hueso de juego es muy parecida a la deformación de hueso, y permite crear una estructura de
esqueleto en la que el hueso padre mueva el hijo. La diferencia es que la deformación de hueso de juego está
optimizada para exportarla a motores de juego, principalmente a Unity.

La deformación de hueso de juego se utiliza principalmente al animar las extremidades de un personaje, como los
brazos o las piernas, agregando fluidez y naturalidad a la animación. La deformación de hueso de juego se puede
manipular para rotar un miembro en una articulación y también para acortar o alargar las extremidades de un
miembro. También es muy útil para doblar el torso.

Las principales diferencias entre las deformaciones de hueso y de hueso de juego es son que la deformación de
hueso de juego no tiene el parámetro Bias (Sesgo) ni valores de regiones de influencia. El resultado renderizado
también es distinto para los pliegues de la articulación. Aparecen ligeramente redondeados.

Deformador de curva

La deformación de curva permite deformar una imagen utilizando los controladores de curva Bézier. Por ejemplo,
al editar curvas, puede deformar una línea recta en un arco o en zigzag. Las deformaciones de curva se utilizan
principalmente para animar elementos que no tienen articulaciones, como características de pelo o faciales. Sin
embargo, en algunos casos se pueden utilizar para animar miembros o crear un estilo de animación concreto,
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parecido al anterior estilo de animación de manguera de goma con curvas típicamente sencillas y fluidas sin
articulación (sin muñecas o codos articulados).

Deformador de envolvente

La deformación envolvente permite deformar una imagen utilizando los controladores de curva Bézier situados
alrededor del contorno de la forma. Las cadenas de deformación envolvente están compuestas por nodos de
deformación de curvas. Se utiliza habitualmente para deformar formas, como el pelo, la capa, la forma del hombro,
la forma de la cabeza, etc. Puede utilizar la deformación de envolvente para deformar un dibujo de modo que
parezca que cambia desde una vista de perfil a una vista frontal para crear rotaciones de cabeza y de personaje
utilizando solo un conjunto de dibujos.

Las principales diferencias entre los deformadores de curva y envolvente es que la cadena de envolvente se puede
cerrar conectando el último nodo de deformación de curva al punto de desplazamiento inicial. Una vez conectado, el
punto de desplazamiento ya no vuelve a colocar la cadena completa, sino solo su propio punto de control.

NOTA: No se recomienda utilizar deformaciones de envolvente en imágenes mapa de bits y texturas.

Rigging

Mediante la herramienta Rigging, puede crear rápidamente un rig de deformación básico. A medida que crea
cadenas, puede agrupar automáticamente los nodos de deformación para mantener la estructura limpia y
organizada.

A medida que cree las cadenas, se mostrarán los controles. Sin embargo, cuando cierre el proyecto, se desactiva la
visualización de los controles de deformación. Al volver a abrir el proyecto, puede mostrar todos los controles o solo
algunos de ellos (consulte Visualización de los controles de deformación en la página 66.

Antes de agregar deformaciones, puede que desee utilizar un tipo de región de influencia predeterminado. Puede
definir estos parámetros en las propiedades de la herramienta Rigging.

La vista de librería de nodos permite añadir manualmente los nodos necesarios para crear el esqueleto de
deformación. Se encuentran disponibles nodos adicionales, como la salida de cinemática.
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Agrupación automática de nodos de deformación

1. En la barra de herramientas Deformation (Deformación), haga clic en la herramienta Rigging .

2. En la vista de propiedades de la herramienta, en la sección Rig Tool Options (Opciones de la herramienta
rig), active la opción Automatically Create Group when Creating a New Deformation Rig (Crear auto-
máticamente un grupo al crear un nuevo rig de deformación) .

Esta opción permite crear automáticamente un grupo de deformación conectado al puerto de entrada del
elemento seleccionado. Este grupo incluye todos los nodos de deformación necesarios creados.

Selección de un elemento para agregar deformación a

1. En la barra de herramientas Deformation (Deformación), haga clic en la herramienta Rigging .

2. En la vista de nodos, cámara o línea de tiempo, seleccione el elemento al que desea agregar la defor-
mación. Al seleccionar un nodo de dibujo, los componentes de deformación se agregarán auto-
máticamente sobre el nodo de dibujo. Al seleccionar un nodo de peg, los componentes de deformación se
agregarán debajo del peg.

NOTA: No coloque nunca un nodo de deformación sobre un nodo de peg. Si hay un peg debajo de un nodo de
deformación (hueso, hueso de juego, curva, etc.) puede producirse un resultado imprevisto. La animación del peg
moverá la imagen fuera de la zona de deformación definida. Lo mismo se aplica a las animaciones creadas en la
propia capa de dibujo. Una capa de dibujo tiene un peg integrado.

3. En la vista de cámara, cree el rig. Consulte los siguientes procedimientos para aprender a agregar un tipo
de deformación específico.
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Adición de una cadena de deformación de hueso y hueso de juego

1. Una vez que se encuentren seleccionados el elemento y la herramienta Rigging, en la vista de propiedades
de la herramienta, active el modo Bone (Hueso) o el modo Game Bone (Hueso de juego) según el obje-
tivo.

2. Coloque el cursor en la raíz del dibujo o del grupo de dibujos, haga clic una vez y suéltelo. Por ejemplo, en el
hombro.

3. Haga clic de nuevo en la ubicación en la que desea que termine el primer hueso y que comience el segundo
hueso. Se insertará automáticamente un punto de control de articulación entre cada hueso que cree. Tenga
en cuenta que los parámetros de articulación forman parte de los nodos de hueso y de hueso de juego desde
Harmony 12.

4. Repítalo hasta que haya terminado de crear la cadena de huesos.

5. Si necesita insertar un hueso entre los existentes, mantenga pulsada la tecla Alt. Cuando se muestre el cur-
sor Insert Bone (Insertar hueso), haga clic en el segmento de hueso existente en la ubicación en la que desea
agregar un hueso adicional.
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l Tenga en cuenta que puede hacer clic en el punto de articulación del hueso para iniciar una
nueva cadena de hueso a partir de ese punto. Una vez que esté seleccionado el punto de la
articulación (blanco), haga clic en la ubicación en la que desee agregar un hueso y se creará
una nueva cadena de huesos, que quedará emparentada a la anterior.

l Cuando varias cadenas controlan el mismo dibujo o grupo de dibujos, se crea auto-
máticamente un nodo de composición de deformación y aparece la vista de línea de tiempo.
En la sección de vínculos adicionales de la vista de línea de tiempo, puede ver los nodos
que están conectados con la composición de deformación.

6. Con los nodos de deformación o de grupo aún seleccionados, en la barra de herramientas Deformation
(Deformación), haga clic en el botón Reset Current Keyframe (Restablecer fotograma clave actual) .
La posición de reposo actual se establecerá como la del fotograma actual.

Adición de una cadena de deformación de curvas

1. Una vez que se encuentren seleccionados el elemento y la herramienta Rigging, en la vista de pro-
piedades de la herramienta, active el modo Curve (Curva) .

2. Haga clic en la raíz del dibujo, por ejemplo, en el hombro, arrastre el cursor para extender el controlador y
suéltelo como lo haría al usar la herramienta Polyline (Polilínea).
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3. Haga clic de nuevo en la ubicación en la que desea que termine la curva y arrastre hacia atrás para extender
el segundo controlador de curva.

4. Repita este proceso hasta que haya terminado de generar la cadena de curva.

NOTA: Tenga en cuenta que puede hacer clic en cualquier punto de la curva (no en el controlador Bézier) para
iniciar una nueva cadena de curva a partir de ese punto. Una vez que esté seleccionado el punto de control
(blanco), haga clic en la siguiente ubicación en la que desee agregar una curva y se creará una nueva cadena, que
quedará emparentada a la curva anterior.
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l Cuando varias cadenas controlan el mismo dibujo o grupo de dibujos, se crea auto-
máticamente un nodo de composición de deformación y aparece la vista de línea de tiempo.
En la sección de vínculos adicionales de la vista de línea de tiempo, puede ver los nodos
que están conectados con la composición de deformación.

NOTA: Los nodos de deformación están apilados unos sobre otros. Puede organizar el sistema de nodos
seleccionándolos todos y haciendo clic en el botón Order Node View Up (Ordenar vista de nodos hacia arriba)

o Node View Down (Vista de nodos hacia abajo) .

NOTA: Puede hacer clic en cualquier punto de la curva (no en el controlador Bézier) para iniciar una nueva
cadena de curva a partir de ese punto. Una vez que esté seleccionado el punto de control (blanco), haga clic en
la siguiente ubicación en la que desee agregar una curva y se creará una nueva cadena, que quedará
emparentada a la curva anterior.

5. Con los nodos de deformación o de grupo aún seleccionados, en la barra de herramientas Deformation
(Deformación), haga clic en el botón Reset Current Keyframe (Restablecer fotograma clave actual) .
La posición de reposo actual se establecerá como la del fotograma actual.

Creación de un rig de deformación de envolvente

1. Una vez que se encuentren seleccionados el elemento y la herramienta Rigging, en la vista de pro-
piedades de la herramienta, active el modo Distorsión de envolvente.

2. Haga clic en el punto de inicio de la forma del dibujo, por ejemplo, en el pómulo, arrastre el cursor para
extender el controlador y suéltelo como lo haría al usar la herramienta Polyline (Polilínea).
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3. Trabajando como lo haría con el deformador de curvas, siga agregando puntos de control alrededor de la
forma. Una cadena de deformación de envolvente está compuesta por deformadores de curva. Puede colo-
car los puntos de control fuera de la línea de contorno. A medida que avanza, coloque el cursor sobre los con-
troladores de la curva Bézier para cambiarlos de posición. Mantenga pulsada la tecla Alt para mover solo uno
de los dos controladores de la curva Bézier.

4. Para cerrar el deformador de envolvente, mantenga pulsada Alt y haga clic en el punto de inicio del des-
plazamiento.
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NOTA: Puede hacer clic en cualquier punto de control (no en el controlador Bézier) para iniciar una nueva
cadena deformación de envolvente a partir de ese punto. Una vez que esté seleccionado el punto de control
(blanco), haga clic en la siguiente ubicación en la que desee agregar una curva y se creará una nueva cadena,
que quedará emparentada a la curva anterior.

l Cuando varias cadenas controlan el mismo dibujo o grupo de dibujos, se crea auto-
máticamente un nodo de composición de deformación y aparece la vista de línea de tiempo.
En la sección de vínculos adicionales de la vista de línea de tiempo, puede ver los nodos
que están conectados con la composición de deformación.

5. Con los nodos de deformación o de grupo aún seleccionados, en la barra de herramientas Deformation
(Deformación), haga clic en el botón Reset Current Keyframe (Restablecer fotograma clave actual) .
La posición de reposo actual se establecerá como la del fotograma actual.

NOTA: No se recomienda utilizar deformadores de envolvente en imágenes mapa de bits y texturas.

Adición de un nodo de deformación

1. En la vista de librería de nodos, seleccione la categoría Deformation (Deformación).

2. En la vista de librería de nodos, seleccione un nodo de deformación y arrástrelo a la vista de nodos. Tenga
en cuenta que los nodos Glue (Pegar), Mesh Warp (Túnel de malla), Refract (Refractar) y Turbulence (Tur-
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bulencia) no están directamente relacionados con el rigging de deformación. Puede obtener más información
acerca de este efecto en la Guía de composición y efectos.

Ajuste de la cadena de deformación

Una vez que haya creado la cadena de deformación, puede optimizar su posición para que se ajuste al elemento que
va a deformar.

Configuración de cadenas de deformación de hueso y hueso de juego

1. En la vista de nodos o de línea de tiempo, seleccione el grupo o los nodos de deformación que contienen la
cadena de deformación que desea definir.

2. En la barra de herramientas Deformation (Deformación), haga clic en el botón Show Selected Deformers and
Hide All Others (Mostrar deformadores seleccionados y ocultar el resto) para mostrar los controles de
deformación en la vista de cámara. De este modo también se ocultan todos los controles de deformación
visualizados

3. En la barra de herramientas Deformation (Deformación), haga clic en la herramienta Rigging .

La cadena cambia de verde a rojo. Una cadena verde indica que la marioneta está en modo de animación.
Una cadena roja indica que la marioneta está en posición de reposo. Asegúrese de que la cadena sea roja.
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4. En la vista de cámara, configure la cadena de deformación.

‣ Gire el primer hueso para cambiar el ángulo de la cadena.

‣ Utilice el control raíz para cambiar de posición (compensar) toda la cadena.

64



Harmony 14.0 Premium - Guía de introducción

‣ Utilice puntos de control para cambiar de posición las articulaciones. De este modo se alargará, acortará
o cambiará la dirección del hueso, y se compensarán los demás secundarios.

‣ Utilice el control de la articulación (cuadrado) para cambiar el tamaño de la misma. Por motivos de
calidad, se recomienda que el diámetro de la articulación se ajuste al de la parte que controla.
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5. Repita el proceso hasta que todas las articulaciones y huesos de la cadena estén correctamente ali-
neados con el elemento con el que están vinculados. También puede definir parámetros adicionales en la
ventana Layer Properties (Propiedades de capa).

6. Con los nodos de deformación o de grupo aún seleccionados, en la barra de herramientas Deformation
(Deformación), haga clic en el botón Reset Current Keyframe (Restablecer fotograma clave actual) .
La posición de reposo actual se establecerá como la del fotograma actual.

7. Utilice la herramienta Transform (Transformar) . Para obtener resultados óptimos, asegúrese de que la
articulación tenga aproximadamente el mismo tamaño que el dibujo.

8. Si necesita insertar un hueso entre los existentes, mantenga pulsada la tecla Alt. Cuando se muestre el
cursor Insert Bone (Insertar hueso), haga clic en el segmento de hueso existente en la ubicación en la que
desea agregar un hueso adicional.

Visualización de los controles de deformación

Antes de manipular el deformador fuera del modo de Rigging, debe visualizar los controles de deformación.

Si acaba de crear el rig de deformación, los controles aún seguirán apareciendo. Sin embargo, al cerrar el
proyecto, los deformadores se desactivan. Al volver a abrir un proyecto, debe visualizar los controles para poder
ver los que necesita durante la animación.

Visualización de los controles de deformación seleccionados

1. En las vistas de cámara, nodo o línea de tiempo, seleccione la capa de dibujo o el grupo o los nodos de
deformación que contienen la cadena de deformación que desea mostrar.
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2. Realice una de las siguientes acciones:

‣ En la barra de herramientas Camera (Cámara), haga clic en el botón Show Control (Mostrar control) .

‣ En el menú superior, seleccione View > Show > Control (Ver > Mostrar > Control).

‣ Pulse Mayús + F11.

Visualización de los controles de deformación seleccionados y ocultación de todos los demás

1. En las vistas de cámara, nodo o línea de tiempo, seleccione la capa de dibujo o el grupo o los nodos de defor-
mación que contienen la cadena de deformación que desea mostrar.

2. En la barra de herramientas Deformation (Deformación), haga clic en el botón Show Selected Deformers and
Hide All Others (Mostrar deformadores seleccionados y ocultar el resto) .

Los controles de deformación seleccionados aparecen en la vista de cámara y los demás quedan ocultos.

Visualización de todos los controles de deformación al mismo tiempo

1. En el nivel superior de la vista de nodos o en la vista de línea de tiempo, seleccione Edit > Select All (Editar >
Seleccionar todo) en el menú superior para seleccionar todos los nodos o pulse Ctrl + A (Windows/Linux) o
⌘ + A (Mac OS X).

2. En la barra de herramientas Camera (Cámara), haga clic en el botón Show Control (Mostrar control) o
pulse Mayús + F11.

Se mostrarán todos los controles de deformación de la escena.

Cómo ocultar los controles de deformación

1. Realice una de las siguientes acciones:

‣ En la barra de herramientas Camera (Cámara), haga clic en el botón Hide All Controls (Ocultar todos los
controles) .

‣ En el menú superior, seleccione View > Hide All Controls (Ver > Ocultar todos los controles).

‣ Pulse Mayús + C.

Animación

Los controles para animar las deformaciones funcionan del mismo modo que los utilizados para configurar las
cadenas. Solo debe crear fotogramas clave y colocar los puntos de control.

Como las deformaciones de envolvente están compuestas por deformaciones de curva, existen muchas
semejanzas en la forma en que se animan.

Animación de deformaciones de hueso y hueso de juego

1. En la vista de línea de tiempo, vaya al fotograma en el que desea crear la primera pose de animación.

2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) .
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3. Si desea crear fotogramas clave de animación, active el modo Animate (Animar) en la barra de herra-
mientas Tools (Herramientas).

4. Realice una de las siguientes acciones:

l En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add Keyframe
(Agregar fotograma clave) .

l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

l Pulse F6.

Se agrega un fotograma clave al fotograma actual.

5. En la vista de nodos o de línea de tiempo, seleccione el grupo o los nodos de deformación que contienen la
cadena de deformación que desea animar (consulte Visualización de los controles de deformación en la
página 66.

6. En la barra de herramientas Deformation (Deformación), haga clic en el botón Show Selected Deformers
and Hide All Others (Mostrar deformadores seleccionados y ocultar el resto) para mostrar el defor-
mador de la pieza seleccionada.

7. En la vista de cámara, realice lo siguiente:

l Gire el primer hueso para rotar el miembro.

l Gire los demás huesos para doblar el miembro.
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l Utilice el control raíz para cambiar de posición (compensar) toda la cadena.

l Utilice puntos de control para cambiar de posición las articulaciones. De este modo se alar-
gará, acortará o cambiará la dirección del hueso, y se compensarán los demás hijos.

l Utilice el control de la articulación (cuadrado) para cambiar el tamaño de la misma. Por motivos
de calidad, se recomienda que el diámetro de la articulación se ajuste al de la parte que con-
trola.

8. En la vista de línea de tiempo, vaya al fotograma en el que desea establecer la siguiente pose clave. Deberá
expandir la exposición para ver los dibujos más abajo en la vista de línea de tiempo.

9. Agregue un fotograma clave en el fotograma actual realizando una de las siguientes acciones:

l En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add Keyframe
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(Agregar fotograma clave) .

l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

l Pulse F6.

10. Repita los pasos anteriores para animar el personaje.

También puede manipular el deformador escribiendo valores directamente en las propiedades de capa de
los nodos del efecto de deformación.
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Capítulo 12: Animación de un personaje Cut-out

Harmony ofrece algunas fantásticas herramientas para animar marionetas. Puede crear una animación sencilla con
la herramienta Transform (Transformar), y también crear animación avanzada utilizando cinemática de avance y
cinemática inversa. Harmony cuenta con funciones de papel cebolla e intercambio de imágenes avanzadas que
ayudan a realizar una animación de manera eficiente y rápida. Para contar con libertad de animación, puede mezclar
varias técnicas de animación distintas, como rigging simple, jerarquía y animación de símbolos.

Creación de una animación Cut-out simple

1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) o
pulse Mayús + T.

2. En la barra de herramientas Tools (Herramientas), active el modo Animate (Animar) de modo que todo lo
que mueva se ajuste al fotograma clave automáticamente.

3. En el menú superior, seleccione Animation > Stop-Motion Keyframe (Animación > Fotograma clave de
Stop-motion) de modo que la interpolación no se cree automáticamente entre fotogramas clave.

4. En la vista de línea de tiempo, contraiga el personaje.

5. En la vista de línea de tiempo, vaya al fotograma en el que desea establecer la primera pose.

6. Para garantizar que no se mueve nada en la nueva pose, en la vista de línea de tiempo, seleccione el foto-
grama correspondiente a la pose, haga clic con el botón derecho y seleccione Add Keyframe (Agregar foto-
grama clave) o pulse F6.

7. En la vista de cámara, seleccione las partes que desea animar.
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8. Utilice la herramienta Transform (Transformar) para rotar, sesgar, escalar o trasladar la selección a su
nueva posición. Para rotar la pieza, sitúe el cursor ligeramente fuera de una esquina hasta que vea el cur-
sor de rotación.

Un nuevo fotograma clave aparece en la vista de línea de tiempo si no había creado uno con anterioridad.
Cree siempre el fotograma clave en primer lugar.

9. En la barra de herramientas Tools (Herramientas), active la función Onion Skin (Papel cebolla) .

10. En la vista de línea de tiempo, vaya al fotograma en el que desea establecer el segundo fotograma clave.
Deberá expandir la exposición para ver los dibujos más abajo en la vista de línea de tiempo.

11. Para garantizar que no se mueve nada en la nueva pose, en la vista de línea de tiempo, seleccione el foto-
grama correspondiente a la pose, haga clic con el botón derecho y seleccione Add Keyframe (Agregar
fotograma clave) o pulse F6.

12. En la vista de cámara, anime el personaje.
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13. Repita este proceso para todas las poses.

Selección de la capa padre o hija

1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) .

2. En la vista de propiedades de la herramienta Transform (Transformar), asegúrese de que esté desactivado el
modo Peg Selection (Selección de peg) .

3. En la vista de cámara de línea de tiempo, seleccione una capa conectada a una jerarquía.

4. En el menú superior, seleccione Animation > Select Parent (Animación > Seleccionar padre) o pulse B para
seleccionar la capa padre. Seleccione Animation > Select Child (Animación > Seleccionar hijo) o pulse
Mayús + B para seleccionar la capa hija.

NOTA: Estos atajos de teclado ignoran cualquier nodo de efecto que se encuentre en la vista de nodos o línea de
tiempo. Solo se tienen en cuenta los nodos de dibujo o peg. Si desea desplazarse por la jerarquía incluyendo los
nodos de efectos, puede crear un atajo de teclado personalizado en el cuadro de diálogo Preferences (Preferencias)
para los comandos Select Parent Skipping Effects (Seleccionar padre omitiendo efectos) y Select Child Skipping
Effects (Seleccionar hijo omitiendo efectos) en la pestaña General. Consulte la Harmony Preferences Guide (Guía de
preferencias de Harmony) para aprender a crear atajos de teclado personalizados.
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Desplazamiento por los hermanos del mismo padre

1. En la vista de nodos, seleccione un hijo de un padre y haga lo siguiente:

‣ Para seleccionar el hermano previo de la familia, pulse /.

‣ Para seleccionar el siguiente hermano de la familia, pulse la tecla de signo de interrogación (?).

Definición de la velocidad en varios parámetros

1. En la vista de línea de tiempo, seleccione un fotograma clave de una o varias capas.

NOTA: Solo se tiene en cuenta el primer fotograma clave seleccionado en cada capa al usar la función Set Ease
for Multiple Parameter (Definir velocidad para varios parámetros). Si hay muchos fotogramas clave seleccionados
en la misma capa, los valores de velocidad se aplicarán solo al primero y el resto se ignorará.

2. Realice una de las siguientes acciones:

‣ En la vista de línea de tiempo, haga clic con el botón derecho y seleccione Set Ease For Multiple
Parameters (Definir velocidad para varios parámetros).
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‣ En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Set Ease For Multiple
Parameters (Definir velocidad para varios parámetros) . Si el botón no está en la barra de
herramientas, puede agregarlo mediante el administrador de barras de herramientas. Haga clic con el
botón derecho en la barra de herramientas y seleccione Customize (Personalizar).

Se abre el cuadro de diálogo Set Ease For Multiple Parameters (Definir velocidad para varios parámetros).

3. En el gráfico, tire del controlador de la curva Bézier para ajustar la velocidad de todas las funciones selec-
cionadas.

4. Para aplicar estos parámetros de velocidad únicamente a un tipo de función determinado, como Rotation
(Rotación) o Scale (Escala), en la sección Filters (Filtros), anule la selección de los tipos de función a los que
no desee que se apliquen.

‣ Motion (Movimiento): aplica los parámetros de velocidad a las funciones Position X (Posición X),
Position Y (Posición Y), Position Z (Posición Z) y 3D Path (Ruta 3D) seleccionadas.

‣ Rotation (Rotación): aplica los parámetros de velocidad a las funciones de ángulo seleccionadas.

‣ Scale (Escala): aplica los parámetros de velocidad a las funciones de escala seleccionadas.

‣ Skew (Sesgar): aplica los parámetros de velocidad a las funciones de inclinación seleccionadas.

‣ Morphing: aplica los parámetros de velocidad a las funciones de velocidad de morphing seleccionadas.
Tenga en cuenta que se aplica cuando la función Morphing Velocity (Velocidad de morphing) de la
ventana Layer Properties (Propiedades de capa), no es la velocidad de morphing básica en la vista de
propiedades de la herramienta.

‣ Other (Otras): aplica los parámetros de velocidad a todas las demás funciones seleccionadas, como
todas las funciones creadas para animar parámetros de efecto.
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5. También puede ajustar la velocidad introduciendo valores en los campos Time Ratio (Ratio de tiempo) y
Value Ratio (Ratio de valor). Los valores se calculan como un porcentaje.

‣ En los campos Left Time Ratio (Ratio de tiempo izquierdo) y Right Time Ratio (Ratio de tiempo
derecho), escriba el valor como porcentaje correspondiente al tiempo que desea que dure la velocidad.
El valor debe estar entre el 0 % y el 100 %.

‣ En los campos Left Value Ratio (Ratio de valor izquierdo) y Right Value Ratio (Ratio de valor derecho),
escriba el valor como porcentaje correspondiente a la intensidad que desea que tenga la
desaceleración. El valor debe estar entre el 0 % y el 100 %.

‣ Si los valores Time Ratio (Ratio de tiempo) y Value Ratio (Ratio de valor) son iguales, el movimiento
será lineal.

6. Haga clic en uno de los siguientes botones:

‣ Apply (Aplicar): aplica los parámetros de velocidad a los fotogramas clave seleccionados.

‣ Apply/Previous (Aplicar/anterior): aplica los parámetros de velocidad a los fotogramas clave
seleccionados y automáticamente se selecciona seleccione el fotograma clave anterior en la línea de
tiempo.

‣ Apply/Next (Aplicar/siguiente): aplica los parámetros de velocidad a los fotogramas clave
seleccionados y automáticamente se selecciona el fotograma clave siguiente en la línea de tiempo.

‣ Close (Cerrar): cierra el cuadro de diálogo. Si no ha aplicado las modificaciones, se cancelarán.

76



Harmony 14.0 Premium - Guía de introducción

Capítulo 13: Creación de plantillas
Puede crear una plantilla a partir de una capa o de celdas. Puede almacenar como una plantilla cualquier elemento
disponible en la vista de línea de tiempo.

Al crear una plantilla desde la vista de línea de tiempo, perderá las conexiones, efectos y agrupaciones adicionales
de la vista de nodos.

Al crear una plantilla seleccionando una capa, se incorporarán la capa y todos los dibujos creados en la misma,
incluso si no están expuestos en la vista de línea de tiempo. La selección de celdas solo guardará en la plantilla
esos dibujos específicos.

Creación de una plantilla desde la vista de línea de tiempo

1. En la vista de línea de tiempo, seleccione varias celdas o capas.

2. En la vista de librería, seleccione una carpeta para almacenar la plantilla.

3. Si una carpeta de librería está bloqueada, haga clic con el botón derecho y seleccione Right to Modify (Dere-
cho para modificar).

4. Arrastre la selección a la carpeta Stage Premium Library (Librería de Stage Premium) o a cualquier otra car-
peta.

5. En el cuadro de diálogo Rename (Cambiar nombre), asigne un nombre a la nueva plantilla.
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Para cambiar el nombre de una plantilla una vez creada, haga clic con el botón derecho en el símbolo y
seleccione Rename (Cambiar nombre).

6. Haga clic en OK (Aceptar).

Importación de una plantilla a la vista de línea de tiempo o de cámara

1. En la vista de librería, seleccione la plantilla que desea importar.

2. Arrastre la plantilla seleccionada a la vista de cámara o a la izquierda de la vista de línea de tiempo.

3. También puede arrastrar una plantilla a la derecha de la vista de línea de tiempo y en capas existentes si la
estructura de capas es igual que la existente.

Creación de una plantilla desde la vista de nodos

Las vistas de línea de tiempo y de nodos muestran distinta información sobre una escena.
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Una plantilla de personaje principal, también llamada plantilla maestra, se crea en la vista de nodos. Esta plantilla
contiene todas las conexiones, efectos, composiciones, nodos, pegs, agrupaciones avanzadas, columnas de
función, longitudes de escena, dibujos, tiempos, etc. La plantilla se guarda en la vista de librería y se debe importar
de nuevo en la escena para usarla, ya sea en la vista de nodos o a la izquierda de la vista de línea de tiempo.

NOTA: Si va a crear una plantilla a partir de una plantilla maestra de rig del personaje, debe contraer todos los
elementos de un peg maestro y colocar un fotograma clave en el primer fotograma antes de crear la plantilla.

Creación de una plantilla desde la vista de nodos

1. En la vista de librería, seleccione la carpeta en la que desea almacenar la plantilla.

2. Si la carpeta de librería está bloqueada, haga clic con el botón derecho y seleccione Right to Modify (Dere-
cho para modificar).

3. En la vista de nodos, seleccione los nodos para crear la plantilla y agrúpelos. Es muy importante que agrupe
el rig de personaje Cut-out antes de almacenarlo en la librería, de modo que los archivos estén organizados.

4. En el menú superior, seleccione Edit > Group > Group Selected Layers (Editar > Agrupar > Agrupar
capas seleccionadas) o pulse Ctrl + G (Windows/Linux) o ⌘ + G (Mac OS X). Asegúrese de tener un nodo
Composte (Composición) debajo de las conexiones antes de agrupar o numerosas conexiones saldrán fuera
del grupo.

5. En la vista de nodos, haga clic en el botón amarillo del nodo del grupo para abrir la ventana Layer Properties
(Propiedades de capa).
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6. En la vista de nodos, seleccione el nodo del grupo y cópielo y péguelo dentro de la carpeta de plantilla en la
vista de librería o pulse Ctrl + C y Ctrl + V (Windows/Linux) o ⌘ + C y ⌘ + V (Mac OS X).

7. En el cuadro de diálogo Rename (Cambiar nombre), asigne un nombre a la nueva plantilla y haga clic en
OK (Aceptar).
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Capítulo 14: Configuración de una escena
La configuración de una escena se puede comparar con la construcción de la escenografía para un programa de
televisión. Este es el punto en el que coloca el elemento de escena, como el encuadre de cámara, los elementos de
fondo y los personajes.

Colocación de la cámara

La acción de la escena tiene lugar dentro del encuadre de cámara, de modo que es muy importante configurarlo
correctamente. Puede ajustar la resolución de la cámara y otros parámetros en la ventana Scene Settings
(Configuración de escena). Consulte el capítulo Inicio de Harmony de la Guía de fundamentos para obtener más
información. Si está trabajando en un proyecto de animación de videojuego, también puede establecer una cámara
ortográfica.

La capa de cámara es estática, lo que significa que si necesita animarla, debe agregar un peg.

Debe agregar a la escena una capa de cámara, de modo que pueda editar el encuadre de cámara. Solo puede ver
una cámara cada vez. Si agrega a la escena varias cámaras, puede utilizar la lista de cámaras para seleccionar la
que está activa. Puede utilizar esta función si aún está trabajando en la composición de escena y tiene distintos
encuadres de cámara para probar.

Puede cambiar la posición del encuadre de cámara directamente en la vista de cámara utilizando las herramientas
de animación avanzada. Otra forma de configurar el encuadre de cámara es escribiendo las coordenadas
directamente en las propiedades de la cámara. Al hacerlo, la cámara se coloca en el punto exacto en el cual desea
que esté en lugar de determinarlo visualmente.

Puede restablecer la cámara fácilmente a su posición original. Mediante el comando de restablecimiento, puede
restablecer el valor del elemento seleccionado al valor inicial de la herramienta activa. Por ejemplo, si está activa la
herramienta Rotate (Rotar) , el ángulo de transformación se restablecerá a 0 y, si está activa la herramienta
Transform (Transformar) , se restablecerán todos los valores de parámetros.

Adición de una cámara en la vista de línea de tiempo

1. Realice una de las siguientes acciones:

‣ En la vista de línea de tiempo, haga clic en el botón Add Layer (Agregar capa) y seleccione Camera
(Cámara).

‣ En el menú superior, seleccione Insert > Camera (Insertar > Cámara).

Se agrega a la escena una nueva capa de cámara y aparece en la vista de línea de tiempo.

NOTA: No puede agregar una cámara dentro de un símbolo.
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Añadir una cámara en la vista de nodos

1. En la vista de librería de nodos, seleccione el nodo Camera (Cámara) y en la categoría de favoritos o de
movimiento.

2. Arrastre el nodo de cámara a la vista de nodos.

Cambio de lugar del encuadre de cámara directamente en la vista de cámara

1. En la barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar) .

2. Realice una de las siguientes acciones:

‣ En el menú superior, seleccione Animation > Tools > Translate (Animación > Herramientas >
Traslación).

‣ En la barra de herramientas Advanced Animation (Animación avanzada), haga clic en la herramienta
Translate (Traslación) .

‣ Pulse Alt + 2.

3. En la vista de cámara, haga clic en el encuadre de cámara (rectángulo delgado) para seleccionarlo. Tam-
bién puede seleccionar la capa de cámara en la vista de línea de tiempo o de nodos.

Se resalta el encuadre de cámara seleccionado.
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4. Arrastre el encuadre de cámara a una nueva posición.

5. Para rotar el encuadre de cámara, realice una de las siguientes acciones para seleccionar la herramienta
Rotate (Rotar):

‣ En el menú superior, seleccione Animation > Tools > Rotate (Animación > Herramientas > Rotar).

‣ En la barra de herramientas Advanced Animation (Animación avanzada), seleccione la herramienta
Rotate (Rotar) .

‣ Pulse Alt + 3.

6. En la vista de cámara, arrastre para rotar el encuadre de cámara hasta que alcance el ángulo de rotación
deseado.
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Restablecimiento de la posición de la cámara

1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar)
o pulse Mayús + T.

2. En la vista de línea de tiempo, de nodos o de cámara, seleccione la capa de cámara.

3. En el menú superior, seleccione Animation > Reset (Animación > Restablecer) o pulse Mayús + R.

La cámara vuelve automáticamente a su posición original.

Colocación de objetos

La configuración de la escena también implica la colocación de los distintos elementos de la escena dentro del
encuadre de cámara.

Paneo de una capa con la herramienta Transform (Transformar)

1. En la barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar) .

2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar)
o pulse Mayús + T.

3. En la vista de propiedades de la herramienta, asegúrese de que esté desactivada la opción Peg Selection
Mode (Modo de selección de peg) .

4. En la vista de cámara, seleccione una capa de dibujo y arrastre la selección a una nueva área. Puede
seleccionar varias capas y cambiarlas de posición al mismo tiempo. Mantenga pulsada la tecla Mayús y
seleccione las distintas capas.
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Rotación de una capa con la herramienta Transform (Transformar)

1. En la barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar) .

2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) o
pulse Mayús + T.

3. En la vista de propiedades de la herramienta, asegúrese de que esté desactivada la opción Peg Selection
Mode (Modo de selección de peg) .

4. En la vista de cámara, seleccione una capa de dibujo.

5. Coloque el puntero fuera de una esquina del cuadro de límite y arrástrelo para rotar.

NOTA:
Al transformar una capa, puede visualizar un controlador de rotación en el cuadro de límite. En el cuadro de diálogo
Preferences (Preferencias), seleccione la pestaña Camera (Cámara) y, a continuación, seleccione la opción Use
Rotation Lever with Transformation Tools (Usar palanca de rotación con herramientas de transformación). Esta
preferencia está desactivada de forma predeterminada.
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Escalado de una capa con la herramienta Transform (Transformar)

1. En la barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar) .

2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar)
o pulse Mayús + T.

3. En la vista de propiedades de la herramienta, asegúrese de que esté desactivada la opción Peg Selection
Mode (Modo de selección de peg) .

4. En la vista de cámara, seleccione una capa de dibujo y empuje o tire del punto de control lateral, superior o
de esquina. Mantenga pulsada la tecla Mayús para bloquear la proporción de la selección.

Sesgo de una capa con la herramienta Transform (Transformar)

1. En la barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar) .

2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar)
o pulse Mayús + T.

3. En la vista de propiedades de la herramienta, asegúrese de que esté desactivada la opción Peg Selection
Mode (Modo de selección de peg) .

4. En la vista de cámara, seleccione una capa de dibujo.

5. Sitúe el puntero entre dos puntos de control y arrástrelo hacia los lados o arriba y abajo.
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Cambio de posición del pivote

Las transformaciones, como rotar, escalar, sesgar y voltear, se realizan respecto a la posición de pivote. Puede
cambiar la posición de este punto de pivote a cualquier lugar utilizando las herramientas de animación avanzada.

Cambio de posición permanente del punto de pivote

1. En la barra de herramientas Advanced Animation (Animación avanzada), seleccione la herramienta Translate
(Traslación) , Rotate (Rotar) , Scale (Escalar) o Skew (Sesgar) .

2. En la vista de cámara, Ctrl + clic (Windows/Linux) o ⌘ + clic (Mac OS X) para seleccionar el elemento.

El punto de pivote aparece en la vista de cámara.

3. Arrastre el punto de pivote a una nueva posición.

Todas las transformaciones, incluidas las existentes, se volverá a calcular conforme a esta nueva posición
de pivote.
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Capítulo 15: Animación de objetos y de la cámara
Cuando se trata de animar objetos, lo hará en capas creando rutas de movimiento. También puede animar la
cámara, que es igual que cualquier otro objeto que puede animar.

Animación de una capa

Puede crear la ruta de movimiento directamente en capas (capas animadas).

Puede controlar y definir una trayectoria utilizando varios parámetros distintos, incluidos:

• Posiciones X, Y y Z (ruta 3D o posiciones separadas)

• Ángulo (rotación)

• Sesgar

• Escalas X e Y

• Ángulo de Euler o ángulo cuaternión (cuando está activada la opción de 3D)

• Escala Z (cuando está activada la opción de 3D)

Cada parámetro tiene su propia curva de función, en la cual puede agregar fotogramas clave y controlar la velocidad.
Si no está familiarizado con los gráficos y curvas de función, se trata de herramientas de fácil uso para controlar
visualmente las trayectorias de las vistas de cámara y línea de tiempo.
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Animación de una capa

1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar)
o pulse Mayús + T.

2. En la vista de propiedades de la herramienta, asegúrese de que esté desactivada la opción Peg Selection
Mode (Modo de selección de peg) .

3. En la barra de herramientas Tools (Herramientas), active el modo Animate (Animar) . Esto permite
crear fotogramas clave en el fotograma actual al mover objetos.

4. En la vista de línea de tiempo, vaya al primer fotograma.

5. En la vista de cámara, seleccione el elemento que desea animar y muévalo a su primera posición.

Se crea un fotograma clave en el primer fotograma de la vista de línea de tiempo.

6. En la vista de línea de tiempo, vaya al fotograma en el que desea establecer la segunda posición.

7. En la vista de cámara, mueva el elemento a su segunda posición.
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Se crea un segundo fotograma clave en la vista de línea de tiempo.

8. Reproduzca su animación.

Para ver las animaciones de movimiento en las vistas superior, lateral o de perspectiva mientras las
reproduce, debe activar la opción Playback (Reproducir). En el menú superior, seleccione Play > Enable
Playback > Top View (Reproducir > Activar reproducción > Vista superior) o Side View (Vista lateral) o
Perspective View(Vista de perspectiva).

Animación de la cámara

La cámara se trata del mismo modo que cualquier otro elemento. Puede utilizar las mismas herramientas y modos
de selección para desplazarla o animarla, pero la cámara es un objeto estático. Para animar la cámara, debe
conectarla a una capa de peg. Un peg es una capa de trayectoria.

Mientras realiza movimientos de cámara, puede utilizar las vistas superior, lateral y de cámara.

Apertura de las vistas superior y lateral

1. Realice una de las siguientes acciones:

‣ En el menú superior, seleccione Windows > Top (Ventanas > Superior) o Side (Lateral).

‣ Desde cualquier vista que ya esté abierta, haga clic en el botón Add View (Agregar vista) situado en
la esquina superior derecha y seleccione Top (Superior) o Side (Lateral).

Cómo agregar una cámara y emparentarla a un peg

1. Si aún no tiene una capa de cámara, realice una de las siguientes acciones:

‣ En el menú superior, seleccione Insert > Camera (Insertar > Cámara).
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‣ En la barra de herramientas Layer (Capas), haga clic en el botón Add Layers (Agregar capas) y
seleccione Camera (Cámara).

‣ En la vista de librería de nodos, seleccione un nodo de cámara y arrástrelo a la vista de nodos.

Se agrega a la escena una nueva capa de cámara y aparece en la vista de línea de tiempo.

2. En la vista de línea de tiempo, seleccione la capa de cámara.

3. En la barra de herramientas Layer (Capas), haga clic en el botón Add Peg (Agregar peg) .

Aparece una capa de peg directamente sobre la capa de cámara, que se conecta a ella automáticamente.

La capa de peg toma automáticamente el nombre de la cámara y agrega el sufijo -P para indicar que se
trata de una capa de peg, por ejemplo, Camera-P (Cámara-P).

Si la nueva capa de pivotes no aparecía directamente encima de la cámara, puede que haya hecho clic en
algún otro lugar de la escena que desactivase la capa a la que desea agregar la capa de peg. Para
resolverlo:

‣ Seleccione la capa de cámara y arrástrela y colóquela debajo de la nueva capa de peg. O bien, elimine
la capa de peg mal colocada, seleccione la capa de cámara y haga clic de nuevo en el botón Add Peg

(Agregar peg).

‣ En la vista de librería de nodos, seleccione un nodo de peg y arrástrelo a la vista de nodos. A
continuación, conecte el puerto de salida del peg al puerto de entrada de la cámara.

También puede pulsar Ctrl + P (Windows/Linux) o ⌘ + P (Mac OS X) para crear un peg y conectarlo a
la cámara, o bien seleccione el nodo de cámara y pulse Ctrl + P (Windows/Linux) o ⌘ + P (Mac OS X)
para crear un peg.
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‣ Puede desconectar una capa de su capa padre manteniendo presionada la tecla Mayús y arrastrando la
capa padre lejos de la capa hija. Coloque los seleccionados entre las otras capas.

Animación de la cámara

1. En la barra de herramientas Tools (Herramientas), active el modo Animate (Animar) .

2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) o
pulse Mayús + T.

3. En el lado derecho de la vista de línea de tiempo, en la capa de peg de cámara, seleccione el fotograma en el
que desee que comience el movimiento de cámara.

4. Realice una de las siguientes acciones:

‣ En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add Keyframe (Agregar
fotograma clave) .

‣ Haga clic con el botón derecho y seleccione Insert Keyframe (Insertar fotograma clave).

‣ Pulse F6.

Aparece un fotograma clave en dicha celda. Los fotogramas que preceden a este fotograma clave
mantendrán la misma posición de cámara que este fotograma clave.

5. En las vistas superior, lateral o de cámara, seleccione la cámara (el cono grande con forma de V) y muévala
a la posición deseada. En la vista de cámara, la cámara está representada por un marco delgado. Debe hacer
clic directamente en uno de los bordes.

93



Capítulo 15: Animación de objetos y de la cámara

6. En la vista de línea de tiempo, haga clic en otra celda un poco más abajo para indicar dónde terminará el
movimiento de cámara.

7. Seleccione la cámara en la vista de cámara, superior o lateral, y muévala a la posición deseada.

Aparece un segundo fotograma clave y se crea una línea entre los dos fotogramas para indicar que el
movimiento posterior entre los fotogramas se va a calcular y que lo renderizará el programa.

8. Reproduzca su animación.
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Capítulo 16: Creación de un multiplano

Para construir un multiplano, debe imaginarse cómo es un entorno real. Mire la imagen de fondo e imagine una
cámara que se mueve por el espacio. Tenga en cuenta que los objetos de la imagen se mueven a distintas
velocidades según donde se encuentren en relación a la lente de la cámara.

Para construir un multiplano, es necesario comprender el fondo de la escena, así como la posición de los elementos
en las distintas capas.

Por ejemplo, en el fondo ilustrado anteriormente, los objetos principales que se deben separar son:
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1. Helecho

2. Torre delantera

3. Segunda torre

4. Luna

5. Estrellas

6. Cielo

Aunque la parte inferior de la torre queda oculta detrás de la planta y la escalera, cada una de las capas multiplano
debe ser un dibujo completo. Esto se debe a que las partes ocultas pueden aparecer durante un movimiento de
cámara más adelante en la escena.

Puede colocar capas en el eje Z utilizando las vistas lateral y superior.

Al colocar el elemento más cerca de la cámara, éste parece más grande. También puede acercar los elementos a
cámara o alejarlos de ella mientras mantiene la misma proporción de tamaño en la vista de cámara.

Es buena idea mantener la vista de cámara abierta para ver el aspecto de la escena mientras coloca los
elementos en las vistas superior y lateral.

Puede ver la información acumulada del valor Z en la vista de coordenadas y puntos de control. Al seleccionar
una celda de dibujo que incluye un fotograma clave, mostrará el valor de Z acumulado.

Cuando una capa está emparentada a otras capas que se mueven hacia delante o hacia atrás en el eje Z, puede
que el valor Z de posición de la capa seleccionada actualmente no sea preciso, puesto que su padre también
tendrá un desplazamiento en el eje Z. El valor acumulado de Z es una compilación de todos los desplazamientos
del eje Z que proporcionarán el valor de desplazamiento final del eje Z real en relación al centro (0,0).
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Colocación de un elemento en las vistas superior y lateral

NOTA: Antes de distribuir capas a lo largo del eje Z utilizando las vistas superior y lateral, anule la selección de la
opción No Z Dragging (No arrastrar en Z) seleccionando Animation > No Z Dragging (Animación > No arrastrar en
Z). Esta opción está desactivada de forma predeterminada.

1. Para mantener la escala visual de la vista de cámara a medida que mueve el elemento, realice una de las
siguientes acciones:

‣ En la barra de herramientas Advanced Animation (Animación avanzada), seleccione la herramienta
Maintain Size (Mantener tamaño) .

‣ En el menú superior, seleccione Animation > Tools > Maintain Size (Animación > Herramientas >
Mantener tamaño).

‣ Pulse Alt + 6.

2. En la vista lateral o superior, seleccione una de las capas de la sección de imágenes en miniatura. También
puede seleccionar una capa en la vista de línea de tiempo.

La capa seleccionada se resalta en las vistas superior, lateral y de cámara.
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3. Arrastre la capa a la posición de profundidad correcta en el cono de cámara. El aspecto del elemento per-
manecerá igual en la vista de cámara.

4. Para aumentar o reducir la escala del elemento en relación a su distancia de la cámara, realice una de las
siguientes acciones:

‣ En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar)
. Asegúrese de que esté desactivada la opción Peg Selection Mode (Modo de selección de peg)
en la vista de propiedades de la herramienta.

‣ En la barra de herramientas Advanced Animation (Animación avanzada), seleccione la herramienta
Translate (Traslación) y seleccione una capa en la sección de imágenes en miniatura de la vista
superior o lateral.

‣ Seleccione una capa en la vista de línea de tiempo.

La capa seleccionada queda resaltada en el cono de cámara.
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5. En la vista superior, arrastre el elemento hacia los lados hasta su posición en horizontal. Mantenga pulsada
la tecla Mayús mientras arrastra el elemento para asegurarse de que solo se mueve a lo largo del eje X.

6. En la vista lateral, arrastre el elemento seleccionado hacia arriba o hacia abajo hasta su posición en vertical.
Mantenga pulsada la tecla Mayús mientras arrastra el elemento para asegurarse de que solo se mueve a lo
largo del eje Y.
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Capítulo 17: Configuración de objetos en el espacio
3D
Una vez que los dibujos y los símbolos estén ensamblados, es momento de colocarlos. En esta sección se explica
cómo hacer esto utilizando el ejemplo de una habitación sencilla.

Colocación de capas en espacios 3D

1. En la vista de línea de tiempo, haga doble clic en la nueva capa para abrir el cuadro de diálogo Layer Pro-
perties (Propiedades de capa).

2. En la pestaña Transformation (Transformación), seleccione la opción Enable 3D (Activar 3D).

3. En la sección Rotation (Rotación), seleccione la opción Euler Angles (Ángulos de Euler).

4. En el campo (x) Axis (Eje (x)), escriba 90 para voltear la planta de manera que quede plana sobre el suelo.

NOTA: Utilice la vista de perspectiva para verlo. Pulse Ctrl + Alt (Windows/Linux) o ⌘ + Alt (Mac OS X) para cambiar
el ángulo de la vista.

5. Para colocar la altura del suelo, escriba valores en la sección Position (Posición) de Layer Properties (Pro-
piedades de capa), utilice la herramienta Translate (Traslación) o Transform (Transformar) .
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6. Repita el proceso para las demás piezas que se deben colocar.

7. Si tiene paredes paralelas, una vez que las haya colocado, seleccione la capa Wall (Pared) en la vista de
línea de tiempo.

8. Realice una de las siguientes acciones para duplicar la capa.

‣ En el menú superior, seleccione Edit > Duplicate (Editar > Duplicar).

‣ Haga clic con el botón derecho y seleccione Edit > Duplicate (Editar > Duplicar).

NOTA: Si el dibujo está dentro de un símbolo, dicho símbolo no se duplicará, sino solo la capa que lo contiene.
De este modo, aún utiliza el mismo dibujo.

9. Una vez que la capa se ha duplicado, utilice la ventana Layer Properties (Propiedades de capa) para intro-
ducir los valores de posición o utilizar las herramientas de transformación.

10. Al utilizar las herramientas de transformación, utilice la vista de cámara, superior o lateral para colocar los
elementos, en lugar de la vista de perspectiva para colocar las capas con precisión.
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11. Si las paredes están en contacto, debe hacer que se crucen extendiendo una de las paredes a través de la
otra. Esto impide que se vea un pequeño hueco entre ambas.

Ahora tenemos una habitación 3D completa.
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Capítulo 18: Importación de sonido y sincronización
de labios

Si decide agregar sonido a la animación, debe preparar primero el sonido fuera de Harmony. Después de ello, debe
agregar un elemento de sonido en Harmony para organizar los archivos de sonido en la animación. El sonido se
reproducirá en la película hasta que llegue al final del archivo o a un fotograma de detención que haya creado en el
editor de elementos de sonido.

Si primero crea el proyecto en Toon Boom Storyboard Pro, el sonido se dividirá automáticamente en las distintas
escenas.

Puede importar archivos de sonido .wav, .aiff o .mp3.

Importación de un archivo de sonido

1. Realice una de las siguientes acciones:

‣ En el menú superior, seleccione File > Import > Sound (Archivo > Importar > Sonido).

‣ En la vista de carta de exposición, haga clic con el botón derecho en cualquier parte del área de
fotogramas y seleccione Import > Sounds (Importar > Sonidos).

‣ En el menú Xsheet (Carta de exposición), seleccione File > Import > Sounds (Archivo > Importar >
Sonidos).

‣ En el menú Timeline (Línea de tiempo), seleccione Import > Sounds (Importar > Sonidos).

Se abre el cuadro de diálogo Select Sound File (Seleccionar archivo de sonido).

2. En el cuadro de diálogo Select Sound File (Seleccionar archivo de sonido), busque y seleccione un archivo
de sonido.

El archivo de sonido aparece como una capa en las vistas de línea de tiempo y de carta de exposición.

105



Capítulo 18: Importación de sonido y sincronización de labios

Sincronización de labios
Agregar una sincronización de labios a un proyecto mejora realmente su calidad y la narración. Sin embargo, puede
ser difícil dar a un personaje la forma de boca adecuada al sonido en un fotograma concreto.

Para resolver este problema, Harmony ofrece una opción de sincronización de labios, que analiza el contenido de
un elemento de sonido y genera una carta de fonemas (consulte a continuación) en función de los ocho fonemas
de animación (A, B, C, D, E, F, G y X para silencio).

Las formas de boca que se utilizan en Harmony se basan en la carta de fonemas convencional utilizada en el
sector de la animación.

NOTA: Las letras utilizadas para representar las formas NO corresponden con un sonido real.

Esta es una aproximación del sonido que puede producir cada forma de la boca en inglés:

• A: m, b, p, h

• B: s, d, j, i, k, t

• C: e, a

• D: A, E

• E: o

• F: u

• G: f, ph

• X: silencio, sonido indeterminado

Puede sincronizar los labios del modo tradicional o dejar que el sistema cree automáticamente la detección
automática.

Puede consultar las posiciones de la carta de fonemas mientras dibuja la forma de la boca del personaje.

Detección automática de sincronización de labios

Harmony puede asignar automáticamente dibujos en un elemento a la carta de fonemas generada para un sonido.
Puede ahorrar tiempo al sincronizar los labios una pista de voz.
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En la vista Layer Properties (Propiedades de capa), puede identificar cada dibujo de labios de un personaje.
Harmony etiqueta automáticamente todas las celdas del elemento de un personaje con el nombre adecuado.

Generación de una detección de sonido para sincronización de labios mediante la vista de propiedades
de capa

1. En la vista de línea de tiempo o de carta de exposición, seleccione la capa de sonido.

Las opciones para dicha capa aparecerán en la vista de propiedades de capa.

2. En las propiedades de capa, haga clic en Detect (Detectar).

Aparece una barra de progreso mientras Harmony analiza los clips de sonido seleccionados y asigna una
letra de sincronización de labios a cada celda de sonido.

3. Haga clic en el botón Map (Asignar) para abrir el cuadro de diálogo Lip-Sync Mapping (Asignación de sin-
cronización de labios).
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4. En el menú Destination Layer (Capa de destino), seleccione la capa que contiene las posiciones de la
boca para la pista de voz del personaje.

5. Si la capa seleccionada contiene símbolos, puede asignar la sincronización de labios utilizando dibujos
situados directamente en la capa o bien utilizar los fotogramas del símbolo. En el campo Symbol Layer
(Capa de símbolos), seleccione Don't Use Any Symbol (No usar ningún símbolo) si desea utilizar los dibu-
jos o el símbolo deseado del menú desplegable.

6. En la sección Mapping (Asignación), escriba el nombre del dibujo o los fotogramas del símbolo en el
campo situado a la derecha del fonema que representa. Si los dibujos ya tienen los nombres de las letras
del fonema, no es necesario hacer nada.

7. Haga clic en OK (Aceptar).

8. Pulse el botón Play (Reproducir) en la barra de herramientas Playback (Reproducir) para ver y oír los
resultados en la vista de cámara. Para reproducir la escena con sonido, active el botón Sound (Sonido)

en la barra de herramientas Playback (Reproducir).
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Capítulo 19: Adición de efectos a una escena

Una vez que la animación está finalizada, puede agregar efectos como desenfoques y brillos para que el proyecto
tenga un aspecto incluso mejor. Harmony proporciona diversos efectos básicos que puede agregar a las capas.

Acerca de los efectos

Un efecto siempre necesita una conexión de dibujo y, en ocasiones, un mate o conexión de forma. Un mate
proporciona información de dibujo que determina el área en la que el efecto se aplicará sobre el dibujo. Los detalles y
los colores dentro del dibujo de mate no son importantes, ya que solo se utilizan la forma y las transparencias. A un
mate también se le conoce como máscara.

El principio de mate se puede demostrar con el efecto de cuchilla.

En general, una capa de dibujo se conecta al puerto derecho del efecto y el mate (máscara) a la izquierda.

El efecto de cuchilla permite cortar una parte de una imagen usando un dibujo de mate Puede utilizar el efecto de
cuchilla para permitir que un personaje desaparezca detrás de un elemento de fondo o para cortar un orificio virtual
en la propia capa. La cuchilla requiere una entrada de mate.
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Ajuste las propiedades de cuchilla para invertir el efecto del mate en una imagen. En lugar de que el objeto oculte
la máscara, solo se verá cuando cruce la zona de forma del mate.

Puede ajustar los parámetros del efecto en la vista de propiedades de capa y vincular cualquiera de ellos a una
columna de función que se animará a lo largo del tiempo. Esto implica que todos los efectos se pueden
personalizar.

Si, además de que una capa corte a otra capa, desea ver la capa cortada, arrastre otra conexión desde el puerto
del nodo de ese dibujo y conéctelo a la composición.

Adición de efectos

En Harmony, puede agregar efectos en la vista de nodos. Puede seleccionar un efecto de la vista de librería de
nodos, arrastrarlo a la vista de nodos y conectarlo a las capas de dibujo para formar una red de nodos. A
continuación, mediante el ajuste de los parámetros de cada nodo, puede conseguir el aspecto exacto que tenga
en mente.

Aunque todos los efectos se deben agregar mediante la vista de nodos, algunos también se pueden agregar
rápidamente mediante la vista de línea de tiempo.

Trabajo con la vista de nodos y la vista de librería de nodos

Si tiene que agregar nuevos efectos y otros nodos a la vista de nodos, tendrá que obtenerlos de la vista de librería
de nodos.
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Al crear un nuevo proyecto en Harmony, el sistema de nodos predeterminado que aparece en la vista de nodos tiene
un aspecto parecido al siguiente.

Adición de efectos en la vista de nodos

1. En la vista de librería de nodos, seleccione un nodo y arrástrelo a la vista de nodos.
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2. En la vista de nodos, haga clic en el puerto de salida o entrada de un nodo y arrastre un cable.

3. Conecte el cable al puerto de salida o al puerto de entrada de otro nodo.

4. Para conectar un nodo entre dos nodos conectados, utilice la tecla Alt a medida que arrastra el nuevo nodo
por la conexión del cable existente. Utilice la misma tecla Alt para desconectar un nodo.

5. Para quitar un nodo, seleccione y pulse Eliminar para quitarlo de la vista de nodos.
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Efecto de cuchilla

El efecto de cuchilla permite cortar una parte de una imagen usando un dibujo de mate Puede utilizar el efecto de
cuchilla para permitir que un personaje desaparezca detrás de un elemento de fondo o para cortar un orificio virtual
en la propia capa. La cuchilla requiere una entrada de mate.

Ajuste las propiedades de cuchilla para invertir el efecto del mate en una imagen. En lugar de que el objeto oculte la
máscara, solo se verá cuando cruce la zona de forma del mate.

Uso del efecto de cuchilla

1. Seleccione una capa de dibujo y realice una de las siguientes acciones:

‣ En la vista de librería de nodos, seleccione el efecto Cutter (Cortador) y arrástrelo a la vista de nodos.

‣ En la vista de nodos, haga clic con el botón derecho y seleccione Insert > Combine > Cutter (Insertar >
Combinar > Cortador).

2. Conecte el nodo Cutter (Cortador) entre el dibujo y el nodo Composite (Composición).
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3. En la vista de dibujo o de cámara, cree un dibujo en una nueva capa que actuará como mate.

4. En la vista de línea de tiempo, haga clic en el botón Collapse/Expand (Contraer/expandir) de la capa
del efecto.

1. Realice una de las siguientes acciones:

‣ Arrastre y coloque la capa de mate junto al campo Matte (Mate).

‣ Conecte el dibujo de mate al puerto de mate del nodo Cutter (Cuchilla).

5. Visualice las propiedades de la cuchilla.
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Propiedades de Cuchilla

Parámetro Descripción

Name (Nombre) Permite cambiar el nombre del nodo.

Inverted (Invertido)
Cuando se habilita esta opción, el nodo de cuchilla invertirá la forma del mate
para cortar el dibujo. En lugar de cortar la imagen cruzándola con el mate, cortará
la parte de la ilustración que quede fuera de la forma del mate.

Animación de un efecto a lo largo del tiempo

Al componer la escena, con frecuencia deseará animar los parámetros de un efecto a lo largo del tiempo. Por
ejemplo, puede realizar un fundido de entrada o de salida en un objeto cambiando el nivel de transparencia con el
tiempo o aumentando el contraste de color en uno de los dibujos en un rango de fotogramas determinado.

Para animar un efecto a lo largo del tiempo, cree una curva de función agregando fotogramas clave a los parámetros
que desee animar. Para ello, utilizará las vistas de propiedades de capa, nodo y línea de tiempo. Puede ajustar la
animación utilizando la vista de función.

Animación de un efecto a lo largo del tiempo

1. Adición de un nodo de efecto a la vista de nodos realizando una de las siguientes acciones:

‣ Haga clic con el botón derecho en la vista de nodos y seleccione Insert > efecto deseado (Insertar >
efecto deseado).

‣ Arrastre un nodo desde la vista de librería de nodos a la vista de nodos.
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2. Conecte el efecto entre el elemento de dibujo en el que desea aplicar el efecto y un nodo Composite (Com-
posición). Puede hacerlo desconectándolo y conectándolo manualmente, o manteniendo presionada la
tecla Alt mientras lo arrastra por una conexión.

El efecto también aparece en la vista de línea de tiempo.

3. Cree la curva de función realizando una de las siguientes acciones:

‣ Haga doble clic en la capa de efecto para mostrar las propiedades del mismo. Haga clic en el botón
Function (Función) del parámetro que desee animar y cree una curva de función.

‣ En la vista de línea de tiempo, expanda los parámetros de la capa del efecto haciendo clic en el botón
Collapse/Expand (Contraer/expandir) . A continuación, haga clic en el botón Function (Función)

del parámetro que desee animar y cree una curva de función.
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4. En la vista de línea de tiempo, vaya al fotograma en el que desea comenzar a animar el efecto.

5. En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add Keyframe (Agregar foto-
grama clave) .

6. En el campo Value (Valor) del parámetro que desee animar, introduzca el valor del fotograma clave. Si los
fotogramas clave son fotogramas clave de Stop-motion, en la vista de línea de tiempo, seleccione los nuevos
fotogramas clave. Haga clic con el botón derecho y seleccione Set Motion Keyframe (Definir fotograma
clave de movimiento).

7. Repita este proceso para cada fotograma clave que se vaya a agregar.
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Capítulo 20: Exportación de una película
Si necesita un archivo de vídeo, puede exportar la animación como una película de QuickTime. Para renderizar una
película de QuickTime con transparencia, debe establecer la profundidad en Millions of Colours + (Millones de
colores +). Puede establecer esta opción al exportar una película de QuickTime.

Si el vídeo exportado es demasiado pequeño o demasiado grande, puede cambiar el tamaño del proyecto desde el
menú superior en Scene > Scene Settings (Escena > Configuración de escena). Cambiará el tamaño de la salida
de vídeo.

Exportación de una película de QuickTime

1. En el menú superior, seleccione File > Export > Movie (Archivo > Exportar > Película).

Se abre el cuadro de diálogo Export to QuickTime Movie (Exportar a película de QuickTime).

2. Haga clic en Browse (Examinar), seleccione una carpeta en la cual guardar la película y asígnele un nombre
de archivo para la exportación.

3. Haga clic en OK (Aceptar).

1. En la sección Display Source (Mostrar original), seleccione el nodo de visualización que desea utilizar para
renderizar el proyecto. Si no hay un nodo de visualización en la escena, la lista desplegable indicará Display
All (Mostrar todo) y renderizará la escena en el mismo orden que la vista de línea de tiempo, incluidos los
nodos que flotan en la vista de nodos. Siempre se recomienda realizar el render desde el nodo de visua-
lización, situado bajo el nodo de composición final, a menos que desee renderizar una sección específica ais-
lada por un nodo de visualización determinado.

2. En la sección Export Range (Rango de exportación), decida si desea exportar toda la escena (All (Todo)) o un
intervalo de fotogramas específico. Si decide lo último, introduzca un rango de fotogramas.
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3. En la sección Resolution (Resolución), seleccione una de las siguientes opciones en el menú:

‣ Una relación de resolución preferida.

‣ Custom (Personalizado): activa los campos Width (Anchura) y Height (Altura) para que pueda
introducir un tamaño específico.

4. En la sección Options (Opciones), haga clic en Movie Options (Opciones de película).

Parámetro Descripción

Video (Vídeo)

Permite la personalización de la configuración, los filtros y el
tamaño de vídeo.

Settings (Configuración): Abre el cuadro de diálogo Standard
Video Compression Settings (Configuración de compresión de
vídeo estándar).

Filter (Filtro): Abre el cuadro de diálogo Choose Video Filter
(Elegir filtro de vídeo), en el que puede seleccionar distintos
filtros para aplicarlos a la exportación de vídeo.

Size (Tamaño): Abre el cuadro de diálogo Export Size Settings
(Exportar configuración de tamaño). La configuración de tamaño
se sobrescribe con la configuración de escena de Harmony.
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Sound (Sonido)
Permite la personalización de los ajustes de sonido.

Settings (Configuración): abre el cuadro de diálogo Sound
Settings (Ajustes de sonido) (ver a continuación).

Prepare for Internet Streaming
(Preparar para streaming de
Internet)

Permite la personalización de las opciones de streaming de
Internet.

5. En la sección Video (Vídeo), haga clic en Settings (Configuración).

Se abre el cuadro de diálogo Standard Video Compression Settings (Configuración de compresión de vídeo
estándar).

6. En el menú Compression Type, seleccione un códec. La disponibilidad de una configuración de compresión
determinada depende del tipo de compresión seleccionado. Por ejemplo, Animation (Animación) es el tipo de
compresión predeterminado y, por lo tanto, la opción Data Rate (Ratio de datos) está atenuada.

7. En la sección Motion (Movimiento), seleccione un valor de Frame Rate (Fotogramas por segundo) de la
lista.

Está establecida de forma predeterminada para coincidir con los fotogramas por segundo (fps) del proyecto
de Harmony. Si selecciona un número de fotogramas por segundo inferior, la reproducción de exportación
será más rápida que el proyecto real. Lo contrario también es cierto para un número de fotogramas por
segundo superior.

8. Si desea insertar fotogramas clave, seleccione la opción Every (Cada) y establezca el número por foto-
grama.

Esta es la opción recomendada por QuickTime. Para obtener más información, consulte la documentación
de QuickTime.

9. En la sección Quality (Calidad), utilice el control deslizante para seleccionar una configuración de calidad.
Recuerda que cuanto mejor es la calidad de la exportación, mayor es el archivo.
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10. En la sección Data Rate (Ratio de datos), seleccione permitir que el programa seleccione auto-
máticamente la tasa de bits óptima, o bien introduzca un ratio restrictivo para ahorrar espacio y permitir
una descarga más rápida sacrificando calidad de exportación.

11. En la misma sección, en el menú Optimized For (Optimizado para), seleccione el método de visualización
previsto para la exportación.

12. Haga clic en OK (Aceptar).

13. Desde el cuadro de diálogo Movie Settings (Configuración de película), haga clic en Sound Settings (Con-
figuración de sonido).

Se abre el cuadro de diálogo Sound Settings (Configuración de sonido).

14. En el menú Compressor (Compresor), seleccione un tipo de compresión. La configuración predeterminada
es None (Ninguno). De este modo se conservará el archivo de sonido original sin perder información. Sin
embargo, un archivo de sonido no comprimido agregará inevitablemente “peso” al tamaño total de la expor-
tación de vídeo.

15. En el menú Rate (Ratio), seleccione un ratio. Es mejor que compruebe y haga coincidir las propiedades ori-
ginales del archivo de sonido. Por ejemplo, si el archivo tiene una tasa de muestreo de sonido de 48 kHz y
elige una tasa de conversión de 22,05 kHz, el sonido se reproducirá a la misma velocidad, pero faltarán las
frecuencias más altas. Para una calidad de sonido de película estándar, seleccione 44.1 kHz o 48 kHz
para la calidad de DVD. Un valor inferior hará que el sonido sea “sordo” o tenga menos brillo. Para ele-
mentos como voz grabada no importa demasiado, pero para la música puede suponer una diferencia detec-
table. Si es necesario tener en cuenta el tamaño del archivo, como en los vídeos para Internet, podría ser
práctico utilizar una tasa inferior.

16. Seleccione Size (Tamaño) y Use (Usar), que están relacionados. Se recomienda comprobar las pro-
piedades del archivo de sonido original. Si el archivo se grabó en un canal (mono), no tiene sentido selec-
cionar la opción de dos canales (estéreo). Aunque el modo puede admitir un canal de 16 bits, la
información adicional no es necesaria. Mono está normalmente emparejado con 8 bits y estéreo con
16 bits.

17. Haga clic en OK (Aceptar).

18. En el cuadro de diálogo Export to QuickTime Movie (Exportar a película de QuickTime), haga clic en OK
(Aceptar).

Aparece una barra de progreso.
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19. Desplácese a la ubicación en el ordenador en la que ha guardado el vídeo de QuickTime y haga doble clic en
ella para ver la exportación.

Configuración de la profundidad en Millions of Colours + (Millones de colores +) para exportar una
película de QuickTime con transparencia

‣ En el cuadro de diálogo Standard Video Compression Settings (Configuración de compresión de vídeo
estándar), seleccione Millions of Colors+ (Millones de colores+) en el menú Depth (Profundidad).
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Glosario
3D stereoscopic
(3D
estereoscópico)

Capacidad de crear imágenes estéreo que, cuando se animan y se ven a través de gafas
con obturador activo 3D o mediante gafas con una lente roja y otra azul, se mostrarán como
una película tridimensional.

alpha channel
(canal alfa)

Canal de imagen que contiene información de transparencia. De partida, una imagen tiene
tres canales: rojo, verde y azul (RGB). El canal alfa es el cuarto canal (A). El mate, o
información de transparencia, se almacena en este cuarto canal. Una imagen sin canal alfa
siempre es opaca.

animatic
(animática)

Película con sonido que se desarrolla a partir del storyboard. El panel de storyboard queda
expuesto durante el transcurso de la escena y, en ocasiones, los personajes se colocan en
una trayectoria para indicar movimiento. Los movimientos de cámara también están
animados. La animática se utiliza para determinar el ritmo de un proyecto y proporciona una
buena visión general del proyecto antes de comenzar la producción.

animation
(animación)

Simulación de movimiento creada mostrando una serie de imágenes o fotogramas.

anime Estilo de animación conocido por su aspecto siniestro y oscuro, popular en Japón.

arc (arco) La acción no suele producirse de forma directa, sino que más bien se suele desplegar en lo
que los narradores denominan un arco. El propósito de un arco de historia es mover un
personaje o situación de un estado o escenario al siguiente.

aspect ratio
(proporción)

Relación entre las dimensiones de anchura y altura de una escena, fotograma o formato de
película. La proporción en televisión es de 4:3 y la proporción panorámica de 16:9.

auto-feed
(alimentador de
papel automático)

Método automatizado de introducir dibujos en un escáner en el que hay varios dibujos
apilados en un alimentador de hojas. Cuando se activa el escáner, los dibujos se digitalizan
de forma consecutiva, sin ninguna otra intervención del usuario.

automatic lip-sync
detection
(detección
automática de
sincronización de
labios)

Asignación automática de dibujos en un elemento a la carta de fonemas generada para un
sonido. Puede ahorrar tiempo al sincronizar los labios una pista de voz.

axis (eje) Línea imaginaria alrededor de la cual rota un objeto.

Para gráficos 2D, hay dos ejes: X (horizontal) e Y (vertical).

Para gráficos 3D, hay tres ejes: X (horizontal), Y (vertical) y Z (profundidad).

En animaciones que rotan constantemente, el elemento de eje especifica alrededor de qué
eje rota el objeto. Un número negativo provoca que una animación gire en sentido contrario
a las agujas del reloj, mientras que un número positivo hace que una animación gire a la
derecha.

background
(fondo)

Parte de una escena que está más alejada hacia la parte posterior. El fondo es la
ilustración, o decoración, sobre la que se produce la animación.

Bézier (curva
Bézier)

Método para definir líneas curvas inventado por el matemático francés Pierre Bézier. Una
curva Bézier es una curva matemática o paramétrica. Las curvas Bézier utilizan al menos
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tres puntos para definir una curva.

bitmap (mapa de
bits)

Imagen compuesta por píxeles con una única resolución (tamaño). Si se amplía demasiado,
perderá definición y comenzarán a aparecer píxeles individuales. A esto se le conoce como
pixelación.

Los archivos de imagen de mapa de bits se definen como una malla rectangular estándar de
píxeles individuales. Cada píxel individual contiene un valor que representa un color
específico.

breakdown
(descomposición)

En animación Cut-out, la descomposición es la acción de descomponer un personaje en
trozos para crear una marioneta con articulaciones. Para descomponer un personaje, el
artista corta partes, como las manos y los brazos, del modelo del personaje y las pega en
capas independientes. A continuación, las articulaciones se fijan y se definen los pivotes.

En la animación tradicional, una descomposición es una pose de animación que
normalmente se encuentra entre dos poses clave. Las poses clave son las poses
principales de una animación y las descomposiciones son poses secundarias que ayudan a
describir el movimiento y la curva de rotación (normalmente denominada arco).

camera shake
(vibración de
cámara)

La vibración de cámara se produce en una escena cuando la cámara se mueve ligeramente
y rápidamente en varias direcciones. Este movimiento da la impresión de impacto,
vibración o, por ejemplo, baches en la carretera.

caption (cuadro
de texto)

Campo de texto que contiene información de diálogo, efectos, sonido o slugging en un
storyboard.

cel (celda) En la animación tradicional, una celda (también denominada celuloide) es una hoja
transparente en la que la animación se tinta y se pinta antes de enviarla a la cámara. El
trazado de la imagen se dibuja en la parte delantera de la celda y, a continuación, se colorea
por la parte trasera.

character design
(diseño del
personaje)

Cada personaje de una película animada se dibuja desde varios ángulos en formato de
estilo póster denominado hoja de modelo, que sirve como referencia para los animadores.

chromatic
aberration
(aberración
cromática)

En óptica, una aberración cromática (CA), acromatismo o distorsión cromática, es un tipo
de distorsión en el que una lente no puede enfocar todos los colores en el mismo punto de
convergencia.

clean up Una vez que los bocetos se han evaluado y aprobado, se quita todo el ruido de la imagen
(líneas sobrantes, notas, etc.) para crear dibujos finales que se pueden tintar, pintar y filmar.
El proceso de clean up hace referencia al trazado de una línea limpia sobre un boceto para
conseguir la versión final o a la eliminación de la suciedad y las líneas adicionales que han
quedado tras el proceso de digitalización.

CMYK Acrónimo en inglés de cián, magenta, amarillo y negro. Estos colores forman el modelo
estándar utilizado en un proceso denominado impresión offset.

colour card (carta
de color)

Una carta de color es una tarjeta que contiene un color sólido con el mismo tamaño que la
cámara. La carta de color rellena el fondo con un color sólido cuando no se ha incluido
ninguna imagen de fondo.

colour model
(modelo de color)

Diseño de color oficial que se debe utilizar para pintar la animación. Un modelo es el diseño
de personaje, prop o ubicación definitivo que cada artista debe seguir para la producción.

colour wheel Visualización del espectro de colores en forma de círculo.
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compositing
(composición)

La composición es la acción de incorporar todos los elementos de una escena para crear el
resultado final antes del renderizado. Por ejemplo, el artista de la composición importará
todas las secuencias, el fondo, las superposiciones y las subcapas de la animación en la
escena y los colocará correctamente. A continuación, el artista definirá el encuadre de
cámara y lo animará en caso necesario. Por último, el animador creará todos los efectos
generados por ordenador para el proyecto.

cross dissolve
(fundido
encadenado)

Efecto utilizado para fundir dos escenas, una dentro de la otra.

cut (corte) Transición directa entre dos escenas. Cuando se utiliza un corte, no se insertan efectos de
transición para pasar de una escena a la siguiente. La primera escena termina y la segunda
comienza inmediatamente.

cut-out a nimation
(animación Cut-
out)

El proceso conocido como animación Cut-out es la acción de animar personajes
compuestos por varias piezas moviéndolos de fotograma en fotograma. La animación Cut-
out se puede generar por ordenador o realizarse del modo tradicional utilizando papel.

cycle (ciclo) Grupo de imágenes que forman juntas una acción, como caminar. Un ciclo es una acción
repetida como un bucle durante un período de tiempo. Puede ser una serie de dibujos o
fotogramas clave animados.

dialogue (diálogo) Texto hablado por un personaje en una película o animación.

dope sheet (carta
de rodaje)

La utilizan los animadores, directores y otros miembros del equipo para trazar la secuencia
y el tiempo de las imágenes, el diálogo, los efectos de sonido, las pistas de sonido y los
movimientos de cámara. Conocida también como carta de exposición.

doping (usar carta
de rodaje)

Asignar un dibujo determinado a un rango de fotogramas.

double bounce
walk (paso con
doble bote)

En los fotogramas clave y las posiciones de paso de un paso con doble bote, el cuerpo es
menor que una línea de referencia dibujada en posición vertical. Durante los intercalados, el
cuerpo está situado sobre esta línea, ofreciendo así un aspecto de rebote.

DPI Siglas en inglés para puntos por pulgada, que representa la medida estándar de resolución
para impresoras computerizadas. En ocasiones se aplica a pantallas, en cuyo caso es más
exacto denominarlo píxeles por pulgada. En cualquier caso, el punto es el elemento discreto
más pequeño que forma la imagen.

ease
(aceleración)

En animación, la velocidad es la aceleración y la deceleración de un movimiento. Puede ser
un movimiento creado mediante una curva de función o una serie de dibujos animados.
Otros términos comunes para aceleración-gradual y desaceleración-gradual son
aceleración y desaceleración.

ease-in
(aceleración-
gradual)

Aceleración gradual en la acción. Conocida también como aceleración.

ease-out
(desaceleración-
gradual)

Desaceleración gradual en la acción. Conocida también como desaceleración.

establishing shot
(plano de

Escena en la cual el espectador puede ver toda el área en la que se está produciendo una
secuencia. Por ejemplo, si un niño está jugando en el patio delantero de su casa, el plano de
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situación sería una escena en la que el visor puede ver la casa, el patio, parte de la calle y
los edificios situados alrededor del punto de acción central. Esto ayuda al espectador a
entender la ubicación de la historia y la orientación de la escena.

exposure
(exposición)

En animación, una exposición es el número de celdas en las que un dibujo aparece en la
escena. Para que un dibujo parezca más grande, la exposición se debe ampliar durante un
número de celdas mayor.

exposure sheet
(carta de
exposición)

Hoja con varias columnas verticales y fotogramas horizontales que se utiliza para indicar el
tiempo de una escena. Cada columna representa una capa de escena. Los números de
dibujos de cada columna se indican y se repiten a lo largo de la cantidad de fotogramas
determinada en la que deben aparecer.

La carta de exposición la utilizan los animadores, directores y otros miembros del equipo
para trazar la secuencia y el tiempo de las imágenes, el diálogo, los efectos de sonido, las
pistas de sonido y los movimientos de cámara. Conocida también como carta de rodaje.

fade in/fade out
(fundido de
entrada/fundido de
salida)

El fundido de entrada o fundido de salida es un efecto de transición utilizado para abrir o
cerrar una secuencia. Un fundido de entrada se produce cuando la primera escena aparece
progresivamente, desde una transparencia total a su opacidad total. Un fundido de salida se
produce cuando la escena desaparece progresivamente, desde la opacidad total a la
transparencia total.

fast-in
(aceleración de
entrada)

Aceleración drástica al principio de la acción.

fast-out
(aceleración de
salida)

Aceleración drástica al final de la acción.

field (campo) Unidad de medida utilizada para calcular el movimiento, el registro y la posición de la
cámara. Una escena de animación estándar tendrá entre 6 y 12 campos.

field chart (hoja
de campos)

Guía que contiene todas las unidades de campo que los artistas de animación y layout uti-
lizan para determinar un tamaño de escena o movimiento de cámara.

film-1.33 Resolución idónea para el formato de película panorámico que se ajusta a la proporción
estándar de 4:3 píxeles.

film-1.66 Resolución idónea para el formato de película panorámico que se ajusta a la proporción de
16:9 píxeles. (Los píxeles son más anchos que altos).

flipping En la animación tradicional, flipping es la acción de pasar por los dibujos de una secuencia
de animación muy rápidamente con el fin de ver la animación en movimiento. Flipping
también puede ser la acción de crear una transición menor de un objeto.

follow-through
(animación
secundaria)

Movimiento secundario provocado por la acción principal. Por ejemplo, un personaje que
corre y lleva puesta una capa. La acción principal es el cuerpo que corre. Esto provocará
que la capa siga el movimiento, aunque no se moverá al mismo tiempo, sino que
reaccionará varios fotogramas después y seguirá la curva de movimiento principal.

forward
kinematics
(cinemática
directa)

La cinemática directa es una función utilizada para animar principalmente personajes 3D y
marionetas Cut-out con jerarquía. Se utiliza para animar una marioneta a partir de una de
sus partes principales, como un hombro, y hacer que el resto del brazo se mueva con ella
como un todo.
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frame (fotograma) Un fotograma de animación es una imagen fotográfica única en una película. En la
animación tradicional, el estándar norteamericano contiene generalmente 24 fotogramas por
segundo, mientras que el estándar europeo es de 25.

frame rate
(fotogramas por
segundo)

Los fotogramas por segundo son la velocidad a la que se reproducen los fotogramas. Se
calcula por lo general en fotogramas por segundo. Por ejemplo, una escena se podría
reproducir a 12, 24, 25, 30 o 60 fotogramas por segundo o a cualquier otro número.

Es la medida de la frecuencia (ratio) a la que un dispositivo de imagen produce imágenes
consecutivas únicas, denominadas fotogramas. El término se aplica por igual a los gráficos
por ordenador, videocámaras, cámaras de película y sistemas de captura de movimiento.

La velocidad de fotogramas se suele expresar principalmente en fotogramas por segundo
(fps) y en monitores de barrido progresivo en hercios (Hz).

function (función) Movimiento, trayectoria o ruta generados por ordenador al que se pueden conectar
parámetros de elementos, otras trayectorias y efectos. La función se puede controlar
agregando fotogramas clave y puntos de control en la curva de función.

gamut (gama) Rango de colores que puede representar un dispositivo determinado.

HDTV Acrónimo en inglés de televisión de alta definición que ofrece una imagen de mayor calidad
que la televisión estándar, ya que dispone de un número de líneas de resolución superior.
Para sacar partido de la calidad superior y utilizar plenamente la configuración de
resolución, el dispositivo de salida debe ser compatible con la tecnología HDTV.

hold Fotograma en la animación en el cual el personaje mantiene su posición sin moverse. Se
puede crear un hold entre dos fotogramas clave cualesquiera.

HSV Siglas en inglés para matiz, saturación y valor. Método para definir los colores en cuanto a
matiz (tinte), saturación (sombra) y valor (tono o luminancia).

in-between
(intercalado)

Dibujos que existen entre las poses clave. Se dibujan para crear transiciones fluidas entre
poses.

ink and paint El proceso ink and paint es la acción de pintar las zonas vacías y colorear las líneas en los
dibujos de animación finales siguiendo un modelo de color.

interpolation
(interpolación)

Movimiento generado por ordenador creado entre dos fotogramas clave. Se puede crear
interpolación, o no, entre los fotogramas clave.

inverse kinematics
(IK) [cinemática
inversa (IK)]

Función utilizada principalmente para animar personajes 3D y marionetas Cut-out con
jerarquía. La cinemática inversa animará una marioneta desde una de las extremidades,
como una mano, y permitirá que el resto del cuerpo la siga con naturalidad.

jump cut (corte de
salto)

Corte brusco entre dos escenas. Normalmente, un corte de salto no es visualmente
agradable. Normalmente lo provoca el final de una escena y el comienzo de otra, con una
imagen parecida. La falta de diferencia provoca que el ojo vea un pequeño salto entre las
dos escenas.

key pose (pose
clave)

Posiciones importantes en la acción que definen los puntos inicial y final de cualquier
transición suave. Las claves, o poses clave, son los dibujos principales de una secuencia
de animación que describen el movimiento. Por ejemplo, si se agita un brazo, las claves
corresponderán al brazo de una extremidad del movimiento de onda y a la otra extremidad.
Al realizar un flipping de dichos dibujos, el animador puede ver el esqueleto del movimiento
sin tener todos los dibujos.

keyboard Una o varias teclas del teclado que, al usarlas, provocan que se realice una operación.
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shortcut s (atajos
de teclado)

keyframe
(fotograma clave)

Posiciones importantes en la acción que definen los puntos inicial y final de cualquier
acción. Un fotograma clave es una posición generada por ordenador en un momento
específico (fotograma) y en una trayectoria determinada.

layer (capa) En animación, una capa es una columna, nivel o personaje individual. Las capas de una
escena están superpuestas para formar la imagen final.

layout Paso de comunicación entre el storyboard y la animación. Es la acción de poner el
storyboard en el modelo. Es decir, el personaje se dibuja siguiendo el diseño del paquete de
modelo, de modo que el animador puede comenzar a trabajar.

El artista de layout dibuja el fondo y crea la cámara y la guía de campo, haciendo coincidir la
escena y el movimiento de la cámara. Por último, el animador dibuja en el modelo las poses
de acción principales.

layout and posing
(layout y pose)

Acción que consiste en poner el storyboard en el modelo (a la escala adecuada) para que el
animador comience a trabajar.

layout artist (artista
de layout)

Artista que dibuja el fondo y crea la cámara y la guía de campo, haciendo coincidir la escena
y el movimiento de la cámara. Dibujará en el modelo las poses de acción principales.

layout planning
(planificación de
layout)

Dibujo de las funciones principales de la escena que se utiliza como referencia al planificar
la animación y ejecutar sus etapas iniciales.

layout process
(proceso de
layout)

Paso de comunicación entre el storyboard y la animación.

library (librería) Zona de almacenamiento que contiene plantillas y recursos que se pueden reutilizar en un
proyecto o escena.

light table (mesa
de luz)

Dispositivo que permite ver otras capas en transparencia mientras trabaja en una capa
determinada.

line of action
(línea de acción)

Dirección que seguirá la acción. Conocida también como línea de acción.

lip-sync
(sincronización de
labios)

Proceso de sincronizar la boca de un personaje en sonidos en la pista de sonido del diálogo.
La boca se ajusta fotograma a fotograma para hacer coincidir el sonido del diálogo y
aparentar que el personaje está hablando. La sincronización de labios se puede utilizar para
cualquier secuencia de sonido y no solo para el habla. Por ejemplo, puede hacer que un
pájaro píe o que un lobo aúlle a la luna.

low resolution
(baja resolución)

Formato idóneo para vídeos destinados a la web, donde el tamaño y la descarga rápida del
archivo de vídeo tienen prioridad respecto a la calidad. Una imagen de baja resolución es
aquella que no contiene detalles precisos.

manual lip-sync
detection
(detección manual
de sincronización
de labios)

Intercambio manual de dibujos de posición de la boca para que coincidan con una pista de
voz. Para este proceso, se utilizan tanto la depuración de sonido (escuchar una onda de
sonido descompuesta fotograma a fotograma) como las sustituciones de dibujos.

master palett Grupo de colores atribuidos a un personaje o prop. La paleta se utiliza durante toda la
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(paleta maestra) producción para mantener la coherencia en el aspecto y para garantizar que se utilicen los
mismos colores durante la producción. Conocida también como paleta.

model/colour
model
(modelo/modelo
de color)

Diseño de personaje, prop o ubicación definitivo que cada artista debe seguir para una
producción. Un modelo de color es el diseño de color oficial que se debe utilizar para pintar
la animación.

morphing Función que permite crear dibujos generados por ordenador entre un dibujo de origen y otro
de destino. La animación creada con la función de morphing se puede reutilizar en distintos
proyectos.

motion keyframe
(fotograma clave
de movimiento)

Fotograma clave con interpolación generada por ordenador.

mouth chart
(carta de fonemas)

Carta basada en los ocho fonemas de la animación (A, B, C, D, E, F, G y X, que se utiliza
para representar el silencio) utilizados para la sincronización de labios.

multiplane
(multiplano)

Efecto de pasar por diversos niveles de dibujos para crear una sensación de profundidad en
un plano. Un multiplano es una escena en la que las capas están colocadas a distintas
distancias de la cámara, de modo que, cuando la cámara se mueve, se produce una ilusión
de profundidad. Con un multiplano, toda la perspectiva y la escala se calculan
automáticamente.

NTSC Sistema de difusión televisiva analógico estándar utilizado en Norteamérica. NTSC se ciñe
a los estándares norteamericanos respecto al modo en que los píxeles rectangulares se
muestran para las pantallas de ordenador y de televisión.

nudge
(desplazamiento
pequeño)

Pequeño empujón (izquierda, derecha, arriba, abajo, hacia delante o hacia atrás) realizado
con las teclas de flecha del teclado en un elemento seleccionado. El desplazamiento
pequeño se utiliza para mover una selección de manera muy ligera y precisa.

onion skin (papel
cebolla)

Función que permite ver los dibujos anterior y siguiente de una secuencia.

overlay
(superposición)

Parte del entorno de una escena, como una silla o un arbusto, que se coloca delante de la
animación principal.

PAL Resolución que funciona mejor con el formato europeo para pantallas de televisión y de
ordenador, ya que los píxeles rectangulares se muestran con una orientación distinta.

palette/master
palette
(paleta/paleta
maestra)

Una paleta o paleta maestra es un grupo de colores atribuidos a un personaje o prop. La
paleta se utiliza durante todo el proyecto para mantener la coherencia en el aspecto y para
evitar cambios de color durante la animación. También se le denomina paleta maestra.

palette style
(estilo de paleta)

Un estilo de paleta es una segunda versión de una paleta existente con un ligero cambio en
el tinte y el valor. Un estilo de paleta se puede utilizar para crear la versión nocturna de una
paleta. También se le puede denominar paleta de clonado.

pan (panear) Mover la cámara atravesando la escena en cualquier dirección.

panel En un storyboard, un panel es un fotograma en un plano. Un plano puede estar compuesto
por uno o varios paneles.

paperless
animation/tradigital

El proceso de animación sin papel es la acción de animar digitalmente. El principal proceso
de animación sin papel es dibujar la animación, fotograma a fotograma, directamente en el
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(animación sin
papel/tradigital)

software.

passing position
(posición de paso)

Al dibujar una secuencia en la que un personaje camina, la posición de paso es el punto en
el que una pierna pasa a la otra.

path of action
(línea de acción)

Dirección que seguirá la acción. Conocida también como línea de acción.

peg En la animación tradicional, es una herramienta utilizada para garantizar el registro preciso
de la acción a medida que se mueven las capas de celdas. En la animación digital, en la que
se realiza un rigging de marionetas más avanzado, se pueden usar capas de pegs. Las
capas de pegs son capas de trayectoria que no contienen dibujos. Son rutas de movimiento
que puede usar para agregar articulaciones de ruta. Para las últimas, también puede utilizar
una herramienta de cinemática inversa.

phoneme
(fonema)

Unidad de sonido de un idioma.

pivot (pivote) Punto alrededor del cual un peg o dibujo rota.

pixel (píxel) Elemento más pequeño de una imagen mostrado en un monitor o pantalla de televisión.

El píxel, abreviatura en inglés de elemento de imagen, es un punto único en una imagen
gráfica. Es una pequeña muestra de una imagen, un punto, un cuadrado o una sección muy
pequeña compuesta de filtrado suavizado. Si acerca el zoom lo suficiente en una imagen
digital, verá los píxeles, que parecen pequeños cuadrados de distintos colores e intensidad.

pose-to-pose
animation
(animación pose a
pose)

El proceso de animación pose a pose es la acción que consiste en crear todas las poses de
acción principales, denominadas poses clave, y después colocar las poses secundarias
entre las claves. Las poses secundarias se denominan descomposición. Por último, el
animador rellena los huecos con los dibujos intercalados para lograr una animación fluida.

rendering
(renderizado)

Paso final de la animación por ordenador. Durante el renderizado, el ordenador toma cada
píxel que aparece en la pantalla y procesa todos los componentes. Además, agrega
desenfoque de movimiento antes de que produzca una imagen final. Es el proceso de
calcular las imágenes finales después del proceso de composición.

resolution
(resolución)

Tamaño de una escena, calculado por lo general en píxeles. Por ejemplo, la resolución
NTSC es de 720 x 480. La resolución debe coincidir con la salida final: HDTV, film-1.33,
film-1.66, NTSC, PAL, baja.

RGB Siglas en inglés para rojo, verde y azul. Método que permite definir el color especificando
las cantidades de estos tres componentes del color.

rigging Proceso de conectar las distintas partes de una marioneta Cut-out.

rotary table (mesa
de disco)

Equivalente al disco/mesa de animación, es un dispositivo que permite rotar el espacio de
trabajo para mayor comodidad mientras se dibuja.

rotoscoping
(rotoscopia)

Técnica de animación en la que los animadores trazan un movimiento de película de acción
en vivo, fotograma a fotograma, para usarlo en películas animadas. Es el acto de esbozar
sobre imágenes de acción en vivo para crear una secuencia animada.

roughs (bocetos) Es un nombre común en una película de animación para un dibujo que se utiliza como
referencia, pero no forma parte de la imagen final. Un layout es un boceto.

Es el esbozo del esqueleto de una animación o diseño. Los bocetos consisten
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principalmente en líneas y formas esbozadas, pero también pueden contener detalles de
diseño.

safe area (zona
segura)

Zona central del fotograma de una escena que no quedará recortada por el fotograma de TV.
Como un fotograma de TV corta un margen del tamaño del fotograma original, al mantener
una zona segura se garantiza que la acción principal de la escena siga siendo claramente
visible una vez que la película se proyecte en televisión.

scene (escena) Plano en una película o programa. Una secuencia está compuesta por varias escenas. Una
escena cambia a otra mediante un corte simple o por transición.

script (guion) Texto original que contiene la información de toda la película o el programa. En animación,
el guion contiene todas las descripciones de la ubicación, el diálogo, el tiempo, etc. Un
proyecto comienza con un guion.

sequence
(secuencia)

Serie de escenas o planos que forman una parte distinta de la historia o película,
normalmente conectadas por la unión de la ubicación o el tiempo.

shot (plano) Escena en una película o programa. Una secuencia está compuesta por varios planos. Un
plano cambia a otro mediante un corte simple o por transición.

slow-in
(aceleración)

Aceleración gradual en la acción. Conocida también como aceleración-gradual.

slow-out
(desaceleración)

Desaceleración gradual en la acción. Conocida también como desaceleración-gradual.

slugging Indicación de los tiempos de inicio y detención de un diálogo y las acciones relevantes.

sound scrubbing
(depuración de
sonido)

Proceso que permite escuchar el sonido en tiempo real, mientras mueve el cabezal de
reproducción hacia delante o hacia atrás. Es muy útil para realizar el ajuste preciso de una
sincronización de labios.

stop-motion
keyframe
(fotograma clave
de Stop-motion)

Fotograma clave sin interpolación generada por ordenador.

storyboard Plan visual de todas las escenas y planos de una animación. El storyboard indica lo que
sucederá, cuándo lo hará y cómo se distribuyen los objetos en una escena.

straight-ahead
animation
(animación
directa)

Técnica en la cual se dibuja por orden una secuencia completa desde la primera posición
hasta la última. Esta metodología requiere muy poca planificación. El lugar en el que el
personaje termina y cómo llega hasta allí pueden ser una sorpresa tanto para el público
como para el animador. Este enfoque es espontáneo y creativo, pero puede generar
resultados imprecisos.

strokes (líneas
vectoriales
transparentes)

Líneas vectoriales invisibles que forman las zonas de dibujo. Se pueden ajustar mediante
controladores de curvas Bézier.

symbol (símbolo) Un símbolo combina animación, ilustración o capas en un único objeto que puede controlar
en una capa. También puede crear símbolos de cada parte del cuerpo en marionetas Cut-
out.

En un símbolo puede colocar lo que desee. Puede utilizar símbolos para animar una
marioneta o crear animaciones reutilizables, como intermitentes.

tablet/pen Dispositivo utilizado junto con un ratón, o en lugar del mismo, para mover el puntero (en
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ocasiones denominado cursor) por la pantalla del ordenador.

template
(plantilla)

Recurso almacenado en la librería que se puede reutilizar en cualquier proyecto. Una
plantilla puede ser un dibujo, una serie de fotogramas clave, un archivo de sonido, un panel,
un personaje Cut-out, un efecto, una trayectoria, una animación o cualquier otra cosa que
se utilice en la animación.

thumbnail
(imagen miniatura)

Imagen muy pequeña utilizada como una referencia o indicador.

timecode (código
de tiempo)

Información de tiempo impresa en un clip de película para indicar la escena, hora, minuto y
segundo que se muestran actualmente en pantalla.

timeline (línea de
tiempo)

Representación horizontal de los elementos, el tiempo y los fotogramas clave de una
escena.

trace and paint
(trazar y pintar)

Una vez que los bocetos de las animaciones se han limpiado y se ha realizado una prueba
de línea o de lápiz final, cada dibujo se traza y se pinta para la animación final. En el mundo
digital actual, esto se puede realizar de maneras distintas a los métodos de celuloide o
acetato tradicionales.

track breakdown
(desglose de pista
de audio)

Desglose de una pista de película animada en sonidos individuales para generar la posición
fotograma a fotograma precisa de cada sonido.

traditional
animation
(animación
tradicional)

Tipo de proceso de animación mediante el cual todas las secuencias de animación se
dibujan a mano en papel antes de digitalizarlos o tintarlos en celdas.

trajectory
(trayectoria)

Ruta o trayectoria generada por ordenador que pueden seguir los elementos. La trayectoria
se puede controlar mediante puntos de control, fotogramas clave y velocidad.

transition
(transición)

Efecto colocado entre dos escenas cuando se pasa de una a otra. Efectos de transición
comunes son el fundido encadenado y el borrado.

underlay (capa
de fondo)

En animación, una capa de fondo es una parte específica de la decoración colocada detrás
de la animación principal.

vector Una imagen basada en vectores está compuesta por puntos y curvas Bézier. El ordenador
lee los puntos y traza los segmentos, vinculándolos para reproducir la forma de imagen.
Una imagen vectorial no contiene tamaño fijo ni resolución. El gráfico se puede ampliar y
distorsionar según se desee y el sistema volverá a calcular los segmentos y reconstruirá
las formas. Las imágenes vectoriales se trasladan y se muestran en píxeles una vez que el
cálculo se ha realizado.

velocity
(velocidad)

En animación, la velocidad es la aceleración o la deceleración de un movimiento. Se puede
alcanzar mediante una curva de función o una serie de dibujos animados. Otros términos
comunes para aceleración-gradual y desaceleración-gradual son aceleración y
desaceleración.

walk cycle (ciclo
de andar)

Serie de dibujos "en el lugar" que describen cómo camina un personaje. La ilusión de
movimiento se crea utilizando paneos de fondo. Para evitar realizar innumerables dibujos,
los animadores suelen realizar un ciclo de andar para un personaje.

zone (zona) Área que se puede pintar con color.
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Índice
3D

configuración de objetos 101

posición de capas 101

a la derecha

rotación 15

a la izquierda

rotación 15

aceleración 133

aceleración-gradual 127

adición

vistas 11

alimentador de papel automático 125

animación 125

cámara 89, 91, 93

capas 89

efectos a lo largo del tiempo 115

objetos 89

animación Cut-out 127

animación de un personaje Cut-
out 71

creación 71

creación de personajes 43

desplazamiento entre iguales 74

piezas de dibujo 43

selección de capas 73

animación sin papel 131

animación tradicional 23, 134

pintado 19-20

trazado de animación 28

animática 125

anime 125

arco 125

atajos de teclado 129

baja resolución 130

bocetos 132

cámara

animación 89, 91, 93

cómo agregar y emparentar con un
peg 91

posición, configuración de
escena 81

canal alfa 125

capa de fondo 134

capas 130

animación 89

colocación en espacio 3D 101

cómo emparentar 48

paneo con herramienta Transform
(Transformar) 84

rotación con herramienta Transform
(Transformar) 85

selección de capa padre o hija 73

sesgo con herramienta Transform
(Transformar) 86

carta de campo 128

carta de color 126

carta de exposición 128

carta de rodaje 127

celda 126

celuloide

consulte celda. 126

ciclo 127

ciclo de andar 134

cierre

huecos 21

cinemática de avance 128

círculo cromático 127

clean up 126

trazado 28

CMYK 126

código de tiempo 134

cómo emparentar

capas 48

composición 127

configuración de escena 81

cambio de posición de pivote 87

cambio de posición de pivote
permanente 87

colocación de cámara 81

colocación de objetos 84

escalado de capa con herramienta
Transform (Transformar) 86

paneo de capa con herramienta
Transform (Transformar) 84

rotación de capa con herramienta
Transform (Transformar) 85

sesgo de capa con herramienta
Transform (Transformar) 86

corte 127

Corte de salto 129

creación

escenas de la escena de
bienvenida 9

creación de personajes

cómo emparentar capas 48

descomposición 43

piezas de dibujo 43

recorte 43

cuadro de texto 126

curva Bézier 125

deformación

ajuste de cadena de
deformación 63

cadena, configuración de hueso y
articulación 63

deformación de huesos 53

rig básico 56

rig de curva 58, 60

rig de hueso 57

rigging 55

visualización de controles de
deformación 66

deformador de huesos 53

animación del deformador de
huesos y articulaciones 67
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rig básico 56

rig de curva 58, 60

rig de hueso 57

rigging 55

depuración 133

desaceleración 133

desaceleración-gradual 127

descomposición 126

cómo emparentar capas 48

personaje 43

piezas de dibujo 43

desglose de pista de audio 134

desplazamiento pequeño 131

detección de sincronización de labios

manual 130

detección manual de sincronización de
labios 130

diálogo 127

dibujo 17

piezas, creación de personajes 43

dibujos

morphing 31

pintado 20

directa 133

diseño del personaje 126

DPI 127

Efecto de tono 115

efectos

acerca de 109

adición 109

animación a lo largo del tiempo 115

Tono 115

eje 125

escalado

capa con herramienta Transform
(Transformar) 86

escenas 133

creación desde la escena de
bienvenida 9

exportación

película 123

QuickTime 123

exposición 128

film-1.33 128

film-1.66 128

flipping 128

fondo 125

fonema 132

fonemas

carta 131

fotograma 129

fotograma clave 130

fotograma clave de movimiento 131

fotograma clave de Stop-motion 133

fotogramas por segundo 129

funciones 129

fundido de entrada 128

fundido de salida 128

fundido encadenado 127

gama 129

guion 133

HDTV 129

herramienta Close Gap (Cerrar hueco)
22

herramienta Transform (Transformar)

capa de escalado 86

capa de paneo 84

capa de rotación 85

capa de sesgo 86

herramientas

Cerrar hueco 22

Hold 129

HSV 129

huecos

cierre 21

imágenes de mapa de bits 126

conversión en dibujo vectorial 41

importación como dibujo de mapa
de bits 39

importación en formato original 35

Imágenes en miniatura 134

importación

archivo de sonido 105

conversión en dibujo vectorial 41

imagen de mapa de bits como dibujo
de mapa de bits 39

imagen de mapa de bits en formato
original 35

plantillas 78

importación de sonido 105

ink and paint 129

intercalado 129

interfaz 11

navegación 13

interpolación 129

lápiz 134

layout 130

layout y pose 130

librería 130

creación de plantillas 77-78

limpieza 27

línea de acción 130, 132

línea de tiempo 134

líneas vectoriales transparentes 133

mesa de luz 130

mesa de rotación 132

model sheet Véase: character design

modelo 131

modelo de color 126, 131

morphing

dibujos 31
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eliminación 33

multiplano 131

creación 95

navegación

acercar 14

acercar o alejar 14

alejar 14

centrado de la pantalla en ratón 15

interfaz 13

paneo 14

pantalla completa 14

restablecimiento de paneo 14

restablecimiento de rotación 14

restablecimiento de vistas 14

restablecimiento de zoom 14

rotación a la derecha 15

rotación a la izquierda 15

volver a centrar vista 14

NTSC 131

objetos

animación 89

configuración en espacio 3D 101

posición 84

PAL 131

paleta maestra 130-131

paletas 131

estilo 131

panel 131

paneo 14, 131

capa con herramienta Transform
(Transformar) 84

restablecimiento 14

pantalla completa 14

papel cebolla 131

peg maestro 50

adición 50

pegs 132

adición de maestra 50

maestra 50

pintado 19

dibujos 20

pivote 132

cambio de posición 87

cambio de posición permanente 87

píxel 132

pixelation Véase: bitmap image

plano 133

plano de situación 127

plantillas 134

creación 77

creación desde la vista de nodos 78

importación 78

pose a pose 132

pose clave 129

posición de paso 132

proceso

pintar 19

proporción 125

QuickTime

exportación 123

renderizado 132

resolución 132

restablecimiento

panear 14

rotación 14

vistas 14

zoom 14

RGB 132

rig de curva

creación 58, 60

rig de hueso

creación 57

rigging 55, 132

adición de peg maestro 50

cadena, configuración de hueso y
articulación 63

cómo emparentar capas 48

rig de curva 58, 60

rig de deformación básico 56

rig de hueso 57

visualización de controles de
deformación 66

rotación

capa con herramienta Transform
(Transformar) 85

restablecimiento de rotación 14

rotación a la derecha 15

rotación a la izquierda 15

rotoscopia 132

secuencias 133

seguimiento 128

sesgo

capa con herramienta Transform
(Transformar) 86

sincronización de labios 106, 130

adición 105

detección automática 107, 125

slugging 133

sonido

depuración 133

importación 105

importación de archivo de
sonido 105

sincronización de labios 105-106

storyboard 133

superposición 131

tableta 134

tradigital 131

transición 134

trayectoria 134

trazado 28
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trazar y pintar 134

usar carta de rodaje 127

vector 134

velocidad 127, 134

configuración en varios
parámetros 74

vibración de cámara 126

vista de librería

importación de plantillas 78

Vista de nodos

desplazamiento por iguales 74

Vista de propiedades de la
herramienta 13

vista lateral

apertura 91

colocación de elementos 97

Vista superior

apertura 91

colocación de elementos 97

vistas

adición 11

Propiedades de herramienta 13

restablecimiento 14

volver a centrar 14

volver a centrar

vista 14

zona 134

zona segura 133

zoom

acercar o alejar 14

alejar 14

en 14

restablecimiento de zoom 14
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